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Welcome

Proxima, an intuitive and flawless video mapping media servers. Our range of Proxima
mapping media servers has been designed for reliable and rapid installation. Proxima is the
result of the merger of Digital Essence, specialist in mapping software with its HeavyM
suite, and Waves System, specialist in professional audiovisual installation equipment.

Safety

Refer to chapter 👉Safety instructions [p.6] of the user guide.

⚠

Proxima Welcome
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1. Safety instructions

CE marking
The CE marking is placed on the label, at the bottom side of the device. It attests to compliance of the
device with low voltage CE directive according to EN 55022 standard, and the Electromagnetic
Compatibility Directive 61000-4-x.

Overview
• The user manual is an integral part of the product. It must always be kept handy & close by. Proper
usage involves strict compliance with the instructions given in this manual.

In the event of return of the equipment, the user manual should be handed over to the new purchaser.

The staff should receive instructions concerning the proper usage of the device.

• Only the use of genuine parts ensures perfect safety for the user and correct operation of the device.
Moreover, only accessories mentioned in the technical documentation or explicitly approved by the
manufacturer must be used. If accessories or consumable products from other brands are used, the
manufacturer cannot stand guarantee for the correct and safe operation of the device.

• Damages caused through the use of accessories or consumable products from other brands will not
entail right to any benefit under the terms of warranty.

• The manufacturer will be liable for the safety, reliability and functioning of the product as long as the
assembly, settings, modifications, extensions and repairs have been carried out by the manufacturer or a
company approved by the manufacturer, and if the device is used in accordance with the instructions

mentioned in this manual.

• The player complies with the technical safety standards in force at the date of print of this manual. All
rights reserved for the electrical diagrams, procedures, names and devices mentioned herein.

• Any reproduction of the technical documentation, even partially, without the written authorization from 
Waves System is prohibited.

General safety instructions
This device has been shipped out from our facilities in perfect working condition. In order to preserve
these conditions, for safety and to avoid any risk of accidental bodily injury, the user must imperatively
follow the safety instructions and read the ‘Caution!' messages included in this manual.

This device, made by Waves System, has been designed in a way that practically eliminates any risk if it
is used in accordance witj its intended purpose. Nevertheless, for the sake of safety, we would like to
draw your attention to the following instructions:

• When using the device, comply with all local rules and regulations in force. Any modification or
conversion of the device automatically entails loss of the certification. The operation of a modified

Warning

CAUTION! DO NOT EXPOSE THE PRODUCT TO HUMIDITY NOR DUST!

Unplug the power supply cable before any servicing

FOR YOUR SAFETY, PLEASE READ CAREFULY THE USER'S GUIDE BEFORE OPERATING YOUR
SERVER Proxima 4020.

⚠

Proxima Safety instructions
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device is liable to a penalty. In the interests of occupational safety, the operator and the user are held
responsible for complying with the regulations.

• Keep the original packing for a possible product reshipment. Also ensure that the packing material is
kept out of the reach of children. Only this original packing ensures optimal protection for the product
during transportation. If a product reshipment appears to be necessary during the guarantee period,
Waves System is not liable for any ensuing damages arising during the transportation and attributable to
a defective packing.

• This device should be used only by persons whose training or knowledge ensures proper handling.

• Before each use, the operator must check that the device is in perfect working condition.

• This product must not be used in places where there is a potential explosion risk. Besides, it must
neither be used in an environment favoring combustion nor in a humid or excessively hot or cold
location.

• Maximal temperature of use: +45°C

• Storage temperature: from 0°C up to +60°C

Safety instructions against risks due to electric currents
• The device must be connected to a grounded AC power outlet or a European standard outlet installed
as per good professional practices.

• Disconnecting means of primary supply: Power outlet is used as the disconnecting means of primary
supply, it shall remain accessible.

• Power supply: 19V DC - 6,32A

• Before connecting the device, check that the mains voltage and frequency match the specifications
indicated on the mains adapter.

• Before powering, check that the device and cables are not damaged. Damaged cables and connections
must immediately be replaced.

• Never allow the power cords to come in contact with other cables. Handle the mains adapter cable as
well as all other cables connected to the mains with extreme care.

• Always connect the power cord to the device first, then to the mains. The power outlet must remain
accessible after the installation.

• Check the device and its mains adapter cable from time to time. Disconnect the device from the mains
when it is no longer used or for the purpose of maintenance.

• Handle the power cord by using only the plug. Never remove the plug by pulling the power cord.

• Electrical connections, repairs, and maintenance must be carried out by qualified personnel.

• Do not switch the device on or off within a short period of time as this reduces its lifespan.

THE LIGHTNING FLASH WITH ARROWHEAD
SYMBOL, WITHIN AN EQUILATERAL TRIANGLE, IS
INTENDED TO ALERT THE USER TO THE PRESENCE
OF UNINSULATED “DANGEROUS VOLTAGE” WITHIN
THE PRODUCT'S ENCLOSURE THAT MAY BE OF
SUFFICIENT MAGNITUDE TO CONSTITUTE A RISK
OF ELECTRIC SHOCK TO PERSONS

Proxima Safety instructions
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THE EXCLAMATION POINT WITHIN AN
EQUILATERAL TRIANGLE IS INTENDED TO ALERT
THE USER TO THE PRESENCE OF IMPORTANT
OPERATING AND MAINTENANCE (SERVICING)
INSTRUCTIONS IN THE LITERATURE
ACCOMPANYING THE APPLIANCE.

Warning, the user's guide must be red each time the
symbol is written.

Direct current

WEEE

User's guide must be red each time this symbol is
written.

Positive electric polarity

Terms of use
• This product has been designed for indoor use only.

• The device must be attached under 2m high from the ground.

• If this device has been exposed to very high temperature fluctuations (e.g.: after transportation), do not
connect it immediately. The condensation formed inside the device could damage it. Allow the device to
reach ambient temperature before connecting it.

• Do not shake the device. Avoid sudden movements during its installation or handling.

• When selecting the spot for installation of the player, ensure that it is not exposed to a high source of
heat, moisture, or dust. There

should not be any cables lying around as they might jeopardize your and others' safety.

Proxima Safety instructions
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2. Configuration

This section contains step-by-step instructions on how to configure your Proxima media
server.

Unboxing
Your media servers is provided with EU, US and UK cords.

The front panel comes with 1 USB4.0 type C, 1 USB3.2 type A and one jack 3.5mm. A power button is
situated on the upper panel of the media server.

The rear panel comes with 2 HDMI 1.4, 2 USB2.0 type A, 2 RJ45 ports and a power supply.

Before power on
Connect the HDMI outputs of the Proxima server to the video projectors.

Connect the Proxima server to the local network.

Connect a computer to the local network.

Power on the Proxima server.

Retrieve the IP address
When the Proxima server is started, get its IP address displayed by the videoprojectors on the top right.

Proxima Configuration

Jan, 11th 2024 9



Connect to the server with your web browser
In the computer's web browser, enter the IP address of the Proxima server to log in the web
administration. Enter the default web administration credentials :

Username : « admin »

Password : « admin »

Configure the server
Go to the « settings » menu to configure your server.

Profile settings
You can tick 2 parameters related to the « My files » window. Hide dotfiles will hide .dot files in the
file manager. « Set exact date format » will display the date of last modification instead of the
elapsed time since last update.

Select your language and renew your password.

Click on save to record your change.

Display settings

Configure each display individually by selecting its resolution, framerate and color profile.

Volume settings
Set the main volume output. You can also mute the volume.

Network
Choose server's network interface. Also Select the DHCP or static IP modes.

Date and time
Use automatic date and times, set NTP server addresses and select the time zone.

Proxima Configuration
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System
Perform the following actions :

Reboot will reboot the server

Shutdown will power off the media server

Maintenance toggle will close the composer and start the composer

System update will update the system if a USB stick is plugged on the machine with the xxx at the
root of the USB stick.

About
This menu displays the current version of the firmware.

Connect to Proxima composer
Go to the left menu, Proxima composer and click on the URL listed in the page. A new window opend in
the web browser with a no VNC application. Fill the password « admin ». You are now remotely connected
to Proxima composer.

2.1. Automating project startup and updating remotely

It's sometimes easier to automate startup tasks instead of having to do them manually
everytime, for instance in the case of permanent video installations, where you might not
even have access to the computer once it is setup.This article presents the options that
can help you make Proxima autonomous.

Automating startup actions
To avoid invasive prompts when Proxima is unattended, you can also disable user warnings that could
popup unexpectedly, like the update and crash notifications at startup or the confirmation warning when
quitting. See the options in the General tab of the Preferences window (Edit → Preferences… or [Ctrl+,]),
under “Misc”.The 4 options presented in this section are independent, but combining them will allow you
to automate a seamless project playback every time the computer is turned on.

Proxima Configuration
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Opening a project automatically when Proxima starts
To open a specific project automatically every time Proxima starts, head over to the Startup tab of
the Preferences window (Edit → Preferences…) and check "Open a project at startup". Use
the "Choose" button next to the option to specify the path of the project.

Note: if a projection is configured in the project (from the Output → Setup… module), it will also be
launched once the project has finished loading.

Starting playback automatically
To start playback automatically once a project has finished loading, head over to the Startup tab of
the Preferences window (Edit → Preferences…) and check "Auto-play sequencer after project load". You
have the choice between two actions: playing the Timeline or turning on Autopilot.

Starting playback automatically
To start playback automatically once a project has finished loading, head over to the Startup tab of
the Preferences window (Edit → Preferences…) and check "Auto-play sequencer after project load". You
have the choice between two actions: playing the Timeline or turning on Autopilot.

Disabling unwanted user prompts

Proxima Configuration
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3. Proxima composer Interface

Proxima composer was designed to be accessible to all, so its interface is stripped-down and user-
friendly. This chapter will give you a quick overview of all its parts and basic navigation.

3.1. Overview & Navigation

The different parts of the interface are easily recognizable thanks to color codes and
spatial organization. The interface was categorized so that each part follows a specific
step in your creation workflow.

1. The work area, that contains the Canvas, its settings and the View toolbar.

2.The top toolbar, that contains the Tools and the Menus.

3.The Mapping panels, that contain the Layers list and the Properties panel.

4.The Content panels, that contain the Group Effects panel and the Sources bin.

5.👉The Sequencer [p.84], that contains all your Sequences and their playback controls.

6.👉The tempo & Audio modules [p.84].

Navigating the interface
Moving

In order to navigate inside the work area, you can press your mouse wheel and move your mouse at the
same time. This will activate the Move tool temporarily.

You can also press [Space], left-click to grab the artboard, and move your mouse at the same time, or
click on the icon    in the View toolbar to toggle the tool.

Zooming

You can zoom in on your work area until 1060% and zoom out to 80%. (The unit is relative, 100% means
the canvas can fit entirely in the work area.)

There are a few ways to do so:

With your mouse, you can scroll your mouse wheel or simply click on the   and   buttons of the
View toolbar. The view bar also contains a button   to reset the zoom to 100% and re-center the
canvas in the workspace.

Alternatively, with the keyboard, you can hold [CTRL/Cmd] and hit [+] to zoom in or [-] 

to zoom out.

Proxima Proxima composer Interface
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Scrolling

Depending on the size of your screen, you might not see the full content of some panels at once

sometimes. This might happen in the Mapping panels , the Content panel or the 👉Sequencer. [p.84]

In that case, you’ll see a scroll bar (horizontal or vertical). Just click to grab it, and drag it in order to show
a hidden part of your panel and access its options.

You can also use your mouse wheel to scroll.

Managing the panels

You will learn throughout this guide how to open, close and sometimes expand and collapse the different
panels in the software.

There are no floating panels in Proxima Composer and you can’t resize the different areas and windows.
However, most dialog windows can be moved by dragging their title bar and some, like
the Controls and Shortcuts windows always stay on top, so that it is easier for you to see the info they
contain while using the interface.

3.2. The work area

The work area is the central space of the interface. It is the artboard on which you will
create your mapping shapes.

The Canvas
The black rectangle in the center corresponds to the Canvas. It corresponds to the area that is displayed
in your output, which means that anything you draw outside of it won't be rendered in your output
window, as shown in the picture above.

The Canvas size is indicated at the top of the work area, and you can configure it from the  Output

Setup. Learn how to setup your Canvas properly in 👉« Setting up the Canvas and launching a projection
[p.23] »👉  [p.23].

Note: the shapes displayed in your work area are always the ones in the currently active sequence (the
one that has a yellow title bar). 
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The View toolbar

At the top of the work area, you'll also find the View toolbar, that contains the following options:

Shapes info:   the total number of shapes in the currently active sequence,   the number of
shapes in your current selection.

Zoom options:   zoom out,   zoom out,   zoom to fit or edit the value precisely in the input field.

Pan options:   move around the work area.

Learn more on how to navigate the work area in « 👉Overview & Navigation [p.13] ».

3.3. The top toolbar

The top part of the Proxima composer interface contains the menu bar and the top toolbar.
That's where you'll find most of the features that will help you create and manage the
settings of your mapping.

The Tools
The main toolbar gives you a quick access to important Proxima tools that you might need to use a lot.
The tools are organized as follows:

Output setup:   opens the Output Setup window, that you'll use to configure and launch an
advanced projection.

Shape drawing tools:  use,  ,  or  to drag & drop quickly a predefined shape in your
work area (respectively a circle, a triangle, a square or a player). Or click the little green arrow to

choose the  Draw or   Edit tool (to, well, respectively draw or edit shapes). Learn more in👉

« creative Shapes ». [p.32]

Creative tools:  enables/disables the Magnet Snap, which helps you snap points together

automatically when you move them close.  enables/disables the option "Show All Centers",

which makes Center points visible all the time.  enables/disables the Cursor tool, which displays
a crosshair in the output to pinpoint the location of your pointer in the canvas.

Controls:  opens the Controls settings window, that lets you configure external controls for

Proxima Composer. Learn more in 👉« Controlling Proxima Composer remotely ». [p.99]

The Menus
The menu bar is situated at the top of your screen, below the title bar. It contains drop-down menus
organized in categories, where you’ll find the majority of the software’s essential functions, such as
opening and saving projects, global preferences or tools for example. Some features are even only
accessible from these menus, like Help resources links or the canvas background options "Show
Preview" and "Show Image".
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For a detailed description of all the options, please refer to the 👉« Menus » [p.138] article.

3.4. The Mapping panels

Located on the left of the interface, the mapping panels contain everything related to the
geometry, transformation and organization of your shapes.

The Layer list

Every time you add an object in your work area, you’ll see it appear in this Layer list. In the list, Faces  ,
Masks   and Players   all have a specific symbol to better differentiate them.

In your mapping, Shapes are always placed in groups, with Masks always at the top of the group they
belong to, and Players and Faces mixed below. This group segmentation will, amongst other things, allow
you to display different built-in effects in the Faces of your mapping. Indeed, all the Faces in a specific
group contain the same group effects.

In addition, know that the order of the layers in the list impacts the rendering order in the output, i.e. if a
Group is above another in the list, it will be rendered in front of it in the output. You can change the
arrangement of Groups and objects in the list with drag & drop movements, among other methods that
will be further discussed later.

In short, you'll see that this panel lets you manage Groups, Shapes and the hierarchy of all these layers in
the selected sequence. Its operation will be detailed throughout this guide, but let’s have a quick
overview of the features it contains here. Many options in this panel will facilitate your workflow:

 Add Group: creates a new Group. If Shapes were selected when you hit the button, they are
directly added to this new group.

,   Move Group Backward / Forward: moves the active Group (in light gray, here Group 1) one
step down / up in the list.

 Lock/Unlock Shapes: depending on the line in the list, you can either lock/unlock one Shape, all
Shapes in a group, or all Shapes in the list at once.

 Show/Hide Shapes: depending on the line in the list, you can either hide/show one Shape, all
Shapes in a group, or all Shapes in the list at once.

 Options: depending on the line in the list, you can either access options for one Shape, one Group
or global options for the whole list.

 Collapse/Expand: folds or unfolds the list of Shapes contained in a group. 

Group name: double-click on it to rename the Group. This is also valid for Shapes.
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Subgroups titles: as we've said before, Masks always have to be at the top of the group and Faces
and Players below them. To help you categorize better if you have a lot of objects, you can choose to
display titlebars for "Masks" and "Shapes" subgroups, as seen in the screenshot above. This option
is located in Edit → Preferences... → General → Interface.

 Group color: indicates the color that the Shapes of this group bear in the work area. Clicking on it
will reveal a 30-color palette that you can choose from to change the Group’s color.

 Group Blend Mode: allows you to choose which of the 26 blend modes to apply on the Group,
defining how it is blended with the visuals below it.

 Group Preset: opens up the list of available Group Presets and associated actions.

 Display mode selector: allows you to choose how to display your Player. Either its content is
displayed in the full Player area, or you can choose to display it only in the Faces of the group it
belongs to.

Note: some of the options detailed above are also accessible from right-click context menus in the work
area.

The Properties panel
When you select an object in your work area or in the Layer list, it might have additional options related to
its geometry or transformation. Some of these options are usually not accessible from the canvas,
hidden, or need a shortcut to be enabled so the Properties panel gives you a quick and easy access to
them.

Note: the Properties panel doesn't handle multi-selection (yet), so you'll only see options appear if you
select one element with properties at a time.

 

Group properties

The properties of a group appear when it is active and no other object is selected in the Canvas. Group

properties are detailed in 👉this article [p.67].

Player properties

Here are the properties you'll find if you select one Player:

Display mode: this lets you choose whether to display the content of your player in the full player
area or just in the faces of its group.

Crop: this lets you access the 👉Slice Selector [p.73] to crop the input displayed in the Player.

Shaders: this section lets you add and manage postprocessing effects on your player. Those are not
counted as "content" per say, as they behave more like "filters" that affect the content in your player.
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Warping: 

this section allows you to use the warping tool on your player to deform its texture.

Shape properties

Here are the properties you'll find if you select one Face:

Rendering: this lets you choose between two render modes for the Face, depending on the
performances/rendering result you wish to achieve. Click on the info icon next to it for more details.

Center: this sections contains the properties of the Center of the Face.

Vertex properties

Here are the properties you'll find if you select one point of a Face:

Handles: this lets you convert your point to a straight point or one of the 3 types of curve points.

Center properties

Here are the properties you'll find if you select a Center :

X and Y: these input fields let you set the coordinates of the Center in the Canvas. You can animate
them with LFOs.

Reset position: this button lets you reset the coordinates of the Center back to coincide with the
geometrical center of the face.

3.5. The Content panels

Located on the right of the interface, the content panels contain all the content you can
include in your mapping shapes, whether it is built-in or external content.

The Group Effects panel

The 3 top right icons lets you open the Group Effects panels. In these panels, you'll find effects, like
geometric animations or transformations, that you can insert in your faces and customize with many
parameters.

Effects can be activated with the switch on each tab and apply on all faces in the active group. To learn

more on how to use these, please follow up 👉this article [p.49] on the subject.

To check out all the existing effects and see some examples, head out to this 👉glossary [p.138].
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The Sources bin

The other kind of content you can display in your shapes is multimedia content. The Sources

Bin contains all the sources you add, which you can then link to👉players [p.32] in order to display them
wherever you want in each sequence. You can even organize them in playlists!

The available types of multimedia content are: Videos, GIFs, Images, Shaders, 👉Syphon/Spout streams
[p.132], 👉NDI streams [p.132], Webcam streams or Text.

Note: you can extend this panel to have a view with 8 media thumbnails in a line (as opposed to 4 like in
the screenshot above).

3.6. The Sequencer

In Proxima Composer, you can divide your projects in Sequences. They are like scenes in
your mapping that allow you to create variety in your project. In each sequence, you are
able to add different effects, shapes, or even play different media. They can be arranged to
be easily triggered manually in a live performance, or playback can be automated for a
show with precise timings.
Located at the bottom of the interface, the Sequencer hosts the modules related to Sequences and their
playback, including a Timeline. Its height can be adjusted by hovering over the top of the title bars and
dragging the resize handle.

3.6.1. 1 & 2 - Sequences

The Sequences module & Sequence settings panel can be opened/closed by clicking on the

associated button from the toolbar on the right of the Sequencer. 
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1. Sequences module

A Sequence is represented by a tile and organized in the grid in the Sequences module. 

You can navigate inside of the matrix by using scroll actions (scrollbars, trackpad, mousewheel,
mousewheel click & drag). Hold [Shift] during a vertical scroll action to scroll horizontally. 

Learn more about it in 👉« Module 1 : Sequences module » [p.84].

2. Sequence settings panel

This panel appears with the sequences modules. It gives you access to the settings of the edited
sequence.

You'll learn more about all the possibilities throughout this guide, but know that you can set a
different Map (a set of shapes), Transition (that is triggered when a sequence is selected/starts), or
even shader effects (that apply on the whole output) on each sequence independently.

3.6.2. 3 & 4 - Timeline and Cues

The Timeline module & Cue settings panel can be opened/closed by clicking on the

associated button  from the toolbar on the right of the Sequencer. 
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3. The Timeline module

The Timeline allows you to prepare a series of automated actions that can be programmed with precise
timings or even be timed with an audio file. Actions are set up by placing Cues along the Timeline and
configuring which event they should trigger once they are reached by the playhead.

The Timeline is divided in three tracks in its middle part:

At the top, the time track, where the playhead runs.

In the center, the cue track, where the cues that trigger playback events are positioned.

At the bottom, the audio track

, where the audio waveform is displayed if you’re using an audio file. 

You can scroll along the length of the Timeline using the scrollbar, a mousewheel click & drag, or by
holding [Shift] while scrolling vertically. A simple vertical scroll with a pad or mousewheel will perform a
zoom centered on your cursor. (You can also zoom out/in with the -/+ buttons on the bottom right.)

When the Sequences module is also displayed, the height of the audio track can be adjusted by clicking
on the double arrows button  : it either has a minimal height or it takes half of the total height of
the Sequencer. 

Learn more about all of this in 👉« Module 2 : the Timeline » [p.84].

4. Cue settings panel

This panel appears with the Timeline and gives you access to the settings of the selected Cue (if there's
one).
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3.6.3. 5 & 6 - Audio analysis & Tempo

The Audio Analysis & Tempo module can be opened/closed by clicking on the associated

button  from the toolbar on the right of the Sequencer. 

These modules give you tools to adapt your mapping to the atmosphere and stay in sync with other
audio and/or visual performers.

They are contained in the same panel and can be folded if needed.

5. Audio analysis module
In Proxima Composer, you can make your effects sound-reactive, to adapt your mapping to the
atmosphere. The Audio Analysis module contains the options that will help you select an audio source,
adjust the gains and define frequency ranges to make your effects react to.

You can turn the module ON with the switch in its header bar and access the settings with the gear icon.

Find out how to manage audio settings and make your effects sound-reactive in « 👉Audio & Tempo

reactivity [p.84] ».

6. Tempo module
This module lets you manage the master tempo of your project in Beats Per Minute (BPM). You’ll see
that you’ll be able to use this tempo throughout your whole project for different purposes, like the speed
of an effect or duration settings, in the autopilot playback mode for instance.

Note: the module also hosts the toggle for the 👉Ableton Link [p.132] protocol, which lets you synchronize
your tempo and autopilot with other apps. Please now that in 2.10 the behavior of the protocol will differ
a bit from the current article and that Ableton Link sync, when ON, applies to the Autopilot playback
option and not the Timeline at the moment. 
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4. Canvas & Output Setup

This section contains resources meant to help you with the setup of the Output in Proxima
Composer, whether you want to simply launch a fullscreen projection or need to have a
more advanced setup.

4.1. Setting up the Canvas and launching a projection

Canvas setup
What is the canvas?

The canvas is the black zone at the center of your work area. It corresponds to the area where content is
rendered in order to be displayed in the output, which means that anything you draw outside of it won't
be rendered.

Be mindful that the canvas size is a different element than the output resolution of your display(s), that's
why it is important to setup both accordingly.

Choosing a canvas size

The canvas size affects how your work in rendered in a display output. You should choose a canvas
resolution that corresponds to the desired output resolution. For example:

If you are using a single projector with a 1920x1080 resolution, you need to put this resolution as
your canvas size.

If you are using multiple displays, the canvas resolution should correspond to the total resolution of
your projection area (minus an eventual margin for edge blending). For instance, with two
1920x1080 projectors side by side, without edge blending you'll need a 3840x1080 canvas.

Note: another example is if you have multiple projectors with the same resolution and want them to
only display the same content, then the total resolution should be that of a single projector.

Setting up a canvas size

By default, the canvas resolution is 1920x1080. To change this value, use the projector icon  in the

top toolbar, or go to Output → Setup... to access the Output Setup window.

At the top of the window, you'll see the Canvas Settings section, where you can input a resolution (Width
x Height).
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Note: the canvas size is the same throughout all sequences of a project.

Output setup
Setting up an output window

You have two choices:

You can launch a simple Fullscreen output: your project is displayed on the screen of your choice,
without any title bar. To launch a quick fullscreen projection on one screen, simply choose a display
from the list in Output → Fullscreen. In this case, the entire canvas is projected, so if it has a
different resolution than the display, the rendering is stretched to fit fullscreen.

You can use the Setup option to configure an advanced output: multiple output displays, with output

warping or edge blending for instance. More on that in 👉this article [p.23].

4.2. Configuring an advanced projection setup with multiple
displays
There are two different projection options, depending on if you simply want a simple Fullscreen
projection (Fullscreen), or a more advanced configuration (Setup).

This article will describe the process of setting up an advanced configuration, with multiple output
screens.

Overview of the Output Setup window

First off, let's start with a quick overview of the Output Setup module (  or Output → Setup...), to give

you an idea of all the available features:
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1. The Canvas Settings section, where you can setup the resolution of the canvas and choose to
display the Test Card in the output to help you in the calibration steps. To better understand the

canvas resolution, please 👉follow this article [p.23].

2. The Screens setup area. This is where you'll setup how many output screens you want and which
area you want them to display by placing them precisely on the canvas. This is also where you'll be
able to adjust the deformation points from the Warping module (see n°4). You can navigate this area
with a mousewheel click or [Space]+Drag and zoom with a mousewheel scroll or the buttons on the
bottom right.

3. The Screen settings section. In this section, you'll be able to adjust the settings of a selected screen:
its Destination (which display to send it the rendering to), its Position (in pixels, relative to the
canvas top left origin), its Orientation (0/90/180/270°), its Name or its Color (only to help identify it
in the Screens setup area).

4. The Warping section. It contains the settings relative to the distortion of a selected screen. The
Warping is used to adjust the corners or create small deformations on the output rendering.

5. The Edge Blending section. It contains the settings relative to the blending of a selected screen.
Edge blending is used to blend screens together in order to create a bigger one seamlessly.

 

Setting up a multiprojection
To help us describe the process of setting up multiple outputs, we'll use the following simple case: two
1920x1080 projectors side by side, displaying different content or different parts of the same content
(without edge blending for now).

To achieve this, here's what we need to do:

1. First, set the canvas resolution to 3840x1080 so that it covers the whole projection area we have
with our two projectors.

2. Then, add a screen to have 1 x 2 screens in the setup area, using the "Screens" spinboxes.
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You can see that in this simple case, the screens are already positioned on the canvas (the whole
zone covered by the testcard) like we want so we don't need to move them: the left screen (1) is
snapped to the left side, so it will project the left half of the canvas, while the other screen (2) covers
the right half.

3. Now we need to assign our screens to our projectors. Select screen 1 and in its settings below,
choose the correct projector in the "Destination" list. Do the same for screen 2.

You'll notice that once you select a Destination, the output is directly launched in fullscreen on the
chosen display.

4. At this step, you should see each half of the test card on your projectors. If you don't need to warp or
edge blend the output, the last thing to do is to hide the test card overlay to reveal your project's
content. To do so, simply untick "Show test card" on the top right corner of the window. 

5. Tada! Just click on "Ok" to save you setup and exit the window.

Note: to help you see which area is covered by a screen and place your shapes precisely on the Canvas,
you can toggle "Show Screens" in the View menu in order to see the outlines of screens.
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4.3. Distorting the Output with the Warping module
The Warping module is a feature of the Output Setup. It is there to let you distort an output to adjust it
precisely on your projection surface.

To use the warping feature, your output needs to be in "Setup" mode (the more advanced one, accessible

from or Output → Setup...).

There are two warping types: Perspective and Linear and both can be combined.

Perspective warping mode
Perspective warping allows you to adjust the corner of a screen to skew its rendering in the output. For
instance it can be used to correct the shape of the output and make it rectangular if your projector is not
perpendicular to the projection surface (like a keystone correction).

1. Select a screen.

2. On the right, select "Perspective" for the Warping type (it's the default one).

3. Select a corner of the screen in the Screens setup area.

4. Move this corner either with your mouse pointer, the arrow keys (to move precisely pixel by pixel) or
by changing its coordinates in the Warping section.

As shown in the screenshot of the output destination just above, the rendering is distorted to correspond
to the deformations you have applied to the Screen in the Output Setup.

Note: the warping distortion only affects the output rendering, it is not reflected on the Canvas in the
work area or in the output setup window.

Linear warping mode
Linear warping allows you to distort only an area of the output, for instance to compensate for asperities
on the projection surface.

1. Select a screen.

2. On the right, select "Linear" for the Warping type.

3. Adjust the number of Subdivisions if needed (from 3 to 15 on each axis).

4. Select a point on the warping grid of the screen in the Screens setup area.

5. Move this corner either with your mouse pointer or with the arrow keys (to move precisely pixel by
pixel).
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As shown in the screenshot of the output destination just above, the rendering is distorted to correspond
to the deformations you have applied to the Screen in the Output Setup.

Note: the warping distortion only affects the output rendering, it is not reflected on the Canvas in the
work area or in the output setup window.

Combining Perspective and Linear warping
When you toggle from one type to the other, it doesn't reset the deformations you have made, so both
types of warping can actually be used in combination.

Note: if you use the reset button in one mode ("Reset corners" for Perspective and "Reset
points" for Linear), it only resets the deformations made for this particular type of warping.

4.4. Blending displays seamlessly with the Edge Blending
module

In « 👉Configuring and advanced projection setup with multiple displays  [p.23]», you've learned how to

arrange the Output Setup in Proxima Composer in order to send areas of the Canvas to different display
destinations.

In the use case we presented (two 1920x1080 projectors), the setup could end there if both projectors
are meant to project on completely different spaces or side by side but with a gap between them. If you
intend to use multiple projectors in order to expand your projection area, you'll need to use the Edge
Blending module in addition.

What's the use of Edge Blending?
In reality, it's virtually impossible to combine precisely two projection areas side by side and make them
seem like a single huge one seamlessly just with warping adjustments and no overlap or gap.

That's why, instead of trying to place the projection areas side by side, it's better to actually voluntarily
make them overlap a bit and then apply some blending transformations to correct the appearance of the
overlap strip.
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These corrections are necessary, otherwise the overlap will be very visible, as you can see below:

Using the Edge Blending module

1. Choose the Setup Output mode with  or Output → Setup....

2. In a simple multiprojection case, our canvas size would be (1920+1920)x1080. But since we're going
to make our areas overlap horizontally, we're gonna "lose" some pixels on the width.

Let's say our overlap is on 400px this time, that makes our canvas size 3440x1080.

3. Add a second screen and snap it to the right side of the test card, so that the canvas is fully covered
and the screens overlap by 400px.

4. Launch the fullscreen projection for each screen by selecting it and assigning it
a Destination output.
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5. Now, you should see something like this on your projection surface (I mean the real life projection
this time):

Note: at this step, if your projectors are not exactly placed side by side with the perfect overlap and
you see on the test card that both areas don't fit perfectly, you should use the Wapring options in
Proxima Composer to correct the geometry of the outputs until you reach a matching rectangular
shape.

Assuming your outputs now create a perfect 3440x1080 rectangular projection area, there's one last
thing to correct: the appearance of the overlap strip. To do so, first select each screen in the Output
Setup and "Enable" their Soft Edge parameter one by one in the Edge Blending section.

6. It already should look better! As you can see, Proxima composer has detected that the screens
overlap on one side and has already applied a correction automatically.

Now, it might not be perfect right away so it's up to you to adjust the Blend Curve and Gamma
Correction settings, until you can see the overlap strip and reach two perfectly blended projection
areas.
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7. You're all set! Just remember to untick "Show test card" (top right corner) to reveal your canvas
and click on "Ok" to save you setup and exit the setup window.
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5. Creating Shapes

This section contains all the info you need to learn how to draw shapes and create the
outline of your mapping.

5.1. What are Shapes?
Shapes are the elements that make up your mapping, they contain the content displayed in your
projection. There are three types of shapes in Proxima: 

👉Faces, [p.32] which contain visual effects from the Proxima library;

👉Payers [p.32], which contain sources, like videos, text or other feeds; 

👉Masks [p.45], which are used to mask an area or simulate hollow shapes and thus don't display any

content.

Every time you add an object in your work area, you’ll see it appear in the Layer list on the left. In the list,
faces   , masks   and players   all have a specific symbol to better differentiate them.

This panel contains many options that will help you manage and arrange all your shapes. Some of them
are accessible from both the work area and this panel. The icons in this panel are presented in the 👉

Interface [p.13] chapter. 

5.2. Drawing Faces
Faces are the geometric shapes that you use to draw the outline of your mapping and where you’ll put
visual effects later. There are some predefined faces or you can draw point-to-point.

Check out the video tutorial below, or follow the written instructions after it.

 httpsyoutu.beSJlm0Os-m2U.url

Creating Faces

Predefined faces

To simplify your work if you only need basic shapes, you can use predefined faces. You can either add a
square, triangle or circle by drag & dropping them from the top toolbar or, from a right-click in the work
area, you can also add regular polygons with 5 to 10 sides.
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Custom faces

To draw a custom face, you first need to enable the Draw tool  from the toolbar or with [CTRL/Cmd +

F].

To start drawing a shape, click where you want to place your first point on the canvas. To add more
points, you have 2 choices:

Simply click again where you want to place new points, and this will add points with no handles and
create straight lines;

Or click & drag when you add a point, and this will add a mirrored tangent to your new point. This
way, you'll create a Bézier curve and you'll be able to adjust your curved path with handles.

When you want to finish a face, simply click on the first point or hit Enter to close your path, or
hit Escape to close the path and exit the Draw mode at the same time.

All paths have to be closed, so they need to have a minimum of 3 points (and 1 Center !), but there is no
maximum limit. In addition, you can totally mix straight segments and curves in the same face!

 

Editing faces

Manipulating faces

Basic manipulation operations and transformations of shapes are described in a 👉dedicated article [p.32].

Moving points

You will notice that there is no difference between custom polygons and predefined shapes. Every dot is
independent and can be placed as you wish. You can select the points of your shapes independently by
simply clicking on them or using a lasso selection. Just like when you select faces, they will turn yellow.
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Then, you can move or delete vertices easily. You can even move corners from different shapes at the
same time! 

Note: faces also have one distinct point, that cannot be deleted and isn't on their outline: the Center +. Its

behavior is detailed in a 👉dedicated tutorial [p.49].

Adding points

You can also add points to existing faces. To do so:

1. Turn the Edit Tool  on by selecting it in the toolbar, using [Ctrl/Cmd + E] or double-clicking on a

face. 

2. Select the face you want to add points to. You will see white dots appear in the middle of its
segments.

3. Simply click on a middle point to add it to the face. You can also directly add a vertex with mirrored
handles if you double-click on the middle point.

4. When you're done editing your faces, simply turn off the Edit tool with Escape or the shortcut, or by
deselecting it in the toolbar.

Note: when the Edit mode is on, you can still manipulate all shapes (move or delete faces, points, handles
etc).

Adjusting handles

As we've showed before, you can mix straight points and curves in the same face when you draw. Curve
points each have two handles that you can adjust and that define the curve of the path. You can also edit
the type of points afterwards, and with even more choices. Indeed, there are 4 types of points in total:

 Straight point: it's the default point when you click with the draw tool. It's a simple point with
no handles. The path between two straight points is a straight line.

 Mirrored handles: it's the default handle type when you add a curve point by clicking and
dragging with the draw tool. Both handles on each side of the point are the same size and they form
a line, they are at the same angle. When you adjust the size or orientation of one handle, the other
one will mirror it.

 Asymmetrical handles: both handles on each side of the point form a line, they are at the
same angle but they don't have to be the same length. When you adjust the size or orientation of one
handle, the other one will mirror the angle, but not the distance.

 Disconnected handles: both handles on each side of the point are completely independent.
When adjust the size or orientation of one handle, the other one will not be affected. This means you
can even have a handle on one side and none on the other side!
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There are a few ways to edit the handle type on a point:

First, know that you can convert a point from Straight to Mirrored (and vice versa) by simply double-
clicking on it. Quick and easy!

To access the 4 types of handles, you can use the handle selector from the properties panel on the
left of the interface. It appears when you have a point selected.

Note: know that when you delete only one handle from a point on a curve, it automatically sets the point
type to Disconnected.

Once you have set the type of handles for a point, you can easily adjust them. As shown in the GIF above,
when you click on a point, its handles appear and you can grab and move the handle control points.
When a handle is selected it turns yellow.

5.3. Drawing Masks

Masks are shapes that allow you to hide a particular part of the output or even make hollow
shapes.
Indeed, a mask affects the group it belongs to, so if you overlap faces from the same group and put a
mask in it, you'll just see black where the mask is, but if you place faces from another group below, you'll
be able to see through the face from the group with the mask!

Note: masks are not affected by group effects and any overflow from its group will not be displayed
inside them, but they can be affected by output effects.

Creating Masks

To make a mask, simply 👉draw a face [p.32] wherever you want, select it and click on the "Use as
Mask" option from the right-click menu or the associated options menu in the layers panel.

Note: you can't directly draw a mask, you always have to draw a face first.
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Editing Masks
To turn a mask back into a face, select it and click on the "Unmask" option from the right-click menu or
the associated options menu in the layers panel.

Basic manipulation operations and transformations of shapes are described in a👉  dedicated article [p.32].

5.4. Drawing Players

Players are the areas where you can add a source of external content. Players can support
these categories of medias: photos, videos, GIFs, Webcam streams, NDI
streams, Generative Shaders, Text.

Creating players
Players are predefined quadrilateral shapes. You can add them by drag & dropping the corresponding
icon from the toolbar (as you would do for faces), by using the shortcut [Shift + P], or from the right-click
menu in the canvas.

To differentiate them from faces in the canvas, they have square vertices instead of round ones.

For photos, videos and GIFs, you can also directly drop your medias in the canvas, it will automatically
create a player that contains it. If you drop more than one at a time, it will even create a playlist with all of
them directly!

Editing Players
Unlike faces and masks, players always have 4 points and you can't curve their sides. However, you can
still move these 4 vertices, it doesn't have to stay a rectangle, and this will stretch what is displayed
inside.

If you need to distort the texture in your player further, you can use the warping module. Warping is a
technique used to manipulate a texture in order to correct its distortion, whether it is to adjust its shape
on a complex surface or for creative purposes. 

Turning on the warping module

The warping module can be toggled on from the properties of a player that appear on the panel on the
left when one is selected, or simply by double-clicking on a player. (To turn it off, just use Escape.)

Once it is on, you'll see points appear on your player. You can then move them to distort your texture. 

5.5. Shape manipulation & transformations

In the previous articles of the "Creating Shapes" section, you've learned how to draw and
edit the geometry of the three different kinds of shapes: Faces, Players & Masks. Here, we'll
present basic shape movements and transformations. These operations apply to all types
of shapes.
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Selecting shapes
Selecting a shape

To select a shape, you can click on it in the layers panel on the left or directly in the canvas. Once
selected, it will turn purple. 

When shapes are not selected, they bear the color of the group they are assigned to (except if they are
masks, then they stay black.) It can be changed by clicking on the color symbol in the Layers panel.

Note: if a shape is hidden, it can’t be selected (neither in the canvas nor in the layers panel). If a whole
group is hidden, you can still click on it in the panel to make it active, but its shapes won’t be selected.

Selecting multiple shapes

To select multiple shapes at the same time, you can use basic key combinations like [CTRL/Cmd] +
click to pick some shapes, [CTRL/Cmd + A] to select all shapes, [Shift] + click to select an array in the
layers panel, or a classic lasso selection. When using the lasso selection, know that a shape needs to be
completely covered by the rectangle in order to be selected entirely, or else it will only grab some of its
vertices!

When you make a selection of multiple objects, a bounding box appears around them.

You can refer to the view toolbar, at the top of the work area, to know how many shapes you have in your
selection (the number next to the yellow icon).

Note: if you click on a group in the layers panel, all the shapes it contains will be selected. But be aware
that you can’t select multiple groups at once.

Selecting overlapping shapes

When you create a mapping with a lot of shapes, there’s a chance some of them will overlap completely.
When you click on a pile, it will always select the one that is at the front (the highest in the layer list). If
you want to reach a shape that is below, the layer tree comes in handy!

Note: sometimes, when similar shapes are placed exactly one above the other, you might not notice that
there are multiple ones in your selection. That’s when the elements of information in the view toolbar and
the layers panel will be helpful.
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Arranging shapes
Shapes can be stacked and their order has an importance. Indeed, shapes are stored in groups and
ordered in a layer pile, which also impacts the rendering in the projection: very basically, what's on top of
the pile will be displayed in front of what's below.

By default, when you create a shape, it is added in the currently active group. If you want to order your
shapes, you can drag & drop items directly in the layer list, or use the features in the options or right-click
context menus.

Specifically, you can use the items from the “Arrange” submenu to change the order of shapes in a
group: “Move to Front” puts a shape above all other faces in its subgroup (masks are separated from
faces and players), whereas “Move Forward” ([CTRL/Cmd + ↑]) just sends it above the next shape above
in the group (and “Move to Back” and “Move Backward” ([CTRL/Cmd + ↓]) will do the opposite).

Note: know that Masks are always at the top of a group. They can be arranged between each other but
they are separated from faces and players. Indeed, in a group there are two implicit subgroups, which you
can display by ticking the option "Layers Panel: show Shapes and Masks subgroups" in Edit
→ Preferences → General → Interface.

Moving shapes
Shapes can be moved when they are selected.

You can use your mouse to grab and drag your selection to drop it to a new location. In the case of a
multi-selection, you can directly grab anywhere inside the bounding box, no need to grab one of the
shapes specifically.

In addition, by holding [Shift] when you drag a selection, you’ll be able to constrain the movement in a
vertical or horizontal translation only. A grey line representing the axis on which your selection is
translated will appear.

Of course, you can also use the arrow keys to move selected faces precisely (hold [Shift] at the same
time for a bigger increment.)

Note: when placing faces, the Mgnet mode, that helps you snap points together, will be extremely helpful
to prevent unwanted blank spaces. It is accessible from the magnet icon in the toolbar or the
shortcut [CTRL/Cmd + M].

Resizing faces
1. Select the shape(s) you want to scale.

2. Hover your pointer close to one edge of your selection.

If there's one shape in the selection, the edges are all lines between 2 vertices.

If there are multiple objects in the selection, the edges are the 4 sides of the bounding box.
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3. When a double arrow cursor appears, left-click and drag your pointer (while holding your click) to
resize.

If you drag the cursor towards the center of the selection, it'll shrink it.

If you drag the cursor away from the center of the selection, it'll enlarge it.

4. Release your click to stop the transformation.

This performs a uniform transformation, relative to the center of the selection's bounding box.

If you want to resize your selection on one dimension only, hold [Shift] when dragging the resize cursor
along the x or y axis.

Rotating shapes
There are two ways to perform a rotation in Proxima. You can either:

Perform a rotation from a menu: simply make your selection of shape(s) and right-click Transform →
Rotation to rotate the selection at a predefined angle.

Perform a rotation with the rotate cursor: 

1. Select the shape(s) you want to scale.

2. Hover your pointer close to one vertex of your selection.

If there's one shape in your selection, any point of your shape will do.

If there are multiple objects in your selection, use one of the four corners of the bounding
box.

3. When a round arrow cursor appears, left-click and drag your pointer around (while holding your
click) to rotate.

4. Release your click to stop the transformation.
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This perform a rotation around the center of the selection's bounding box.

Additionally, hold [Shift] when dragging the rotate cursor to perform a rotation in 15° steps.

Duplicating shapes
You can use the usual right-click or shortcut commands to copy [CTRL/Cmd + C] / cut [CTRL/Cmd + X] /
paste here [CTRL/Cmd + V] / paste in place [CTRL/Cmd + Shift + V] or duplicate [CTRL/Cmd + D].

If you use "paste here", the selection will be pasted where your mouse pointer is located. With "paste in
place", the selection is pasted at the same coordinates as the original one (no matter the Map). 

You can also press [Alt] while dragging a selection to duplicate it.

Performing symmetries
Performing symmetries

Symmetries in Proxima allow you to make a reflection of the shapes you have selected, with respect to a
vertical or horizontal axis (all the while keeping the original shapes).

Simply select the shapes you want to mirror, and then right-click Transform → Symmetry or use the
shortcut corresponding to the desired type of symmetry. Here are the four types:

Mirror Up [Ctrl + Shift + ↑]

Mirror Down [Ctrl + Shift + ↓]
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Mirror Left [Ctrl + Shift + ←]

Mirror Right [Ctrl + Shift + →]

Note: a symmetry might affect the left-right direction of your effects.

Deleting shapes
To delete shapes, simply make a selection and hit [Delete/Backspace] or use the item in the right-click
menu or the option menus in the Layers panel.

5.6. Using Maps to create multiples drawings

In other articles of this chapter, you've learned how to draw shapes and what they are used
for. We've focused on creating one set of shapes, but what about when you have multiple
sequences? You might want to use the same drawing in all sequences, or create a different
one for each for example.This article aims to help you achieve what you want in terms of
drawing, when you start creating more complex projects with multiple sequences.
Specifically, it explains the concept of Maps, which are presets of drawings.

What are Maps ?
Your shapes drawings are stored in Maps, which are kind of like templates you create. You can have as
many as you want and you can choose which one to use in each sequence. For example, that means
that you can have Map 1 with a few faces in sequences 1 and 4, and Map 2 with a other faces and a few
players in sequences 2 and 3. 

This might seem vague for now, so keep reading until the end of this article for a presentation of different
use cases.
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Managing Maps
Creating a Map

1. To create a new map, first head over to the settings of a sequence and click on Map settings button.

2. This will open the Map Management window.

3. From there, click on the + button and choose one of the available options:

Create New: this creates a new blank Map (it contains no shape.)

Create New from

This is useful if you want to start with the same base as an existing Map in the project. It creates a
new map that is a copy of the one you selected in the list.

Note: this is equivalent to creating a new Map and then copy/pasting all shapes from another Map
using the paste in place option (right-click menu or [CTRL/Cmd + Shift + V]).

Import from Project: this lets you reuse Maps from other Proxima projects. Choose a project file
from the browser to get the list of Maps that exist this project. There, just tick the ones you want to
reuse and click on Import!

Editing a Map
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The thing with maps, is that you don't have to save your drawing modifications, it's automatic and the
changes are applied to all instances of the same Map. For instance, if you add a circle in Map 1, it will
appear in all sequences that are using Map 1. They kind of are like Symbols or Components, if you're
familiar with Sketch, Figma or other drawing software.

Maps are also totally independent from each other, when you draw in one, you can be sure you're not
affecting the shapes in other Maps!

Note: you can change the name of a Map from the Map Management window, by using the pen icon or
double-clicking on its name.

Switching from one Map to another

Once you've created more than one Map, you can change which one is used in a sequence. Simply go
back to the settings of a sequence and choose an existing Map from the dropdown menu:

You can do so even after you've started creating shapes in a sequence. However, when you switch Maps,
the groups in the sequence don't change. That way, you don't lose the effects they contain. But since all
shapes have changed and Maps don't store any information on groups, all shapes will be put in one
single group, so you'll have to redispatch them.

Indeed, Maps only contain shapes and their geometric features (coordinates of vertices, locked or not,
masked or not, name). Groups and effects are not stored in Maps. Groups only exist in the sequence in
which they are created, if you want to reuse the same groups in a different sequence, copy/paste or
duplicate the sequence.

Note: when you add a new sequence, by default it uses the same Map as the previously selected
sequence.

Deleting a Map

To delete a Map, click on its associated cross icon in the Map Management window. 

Note: all sequences that were using this Map will default to the first one in the list.

Use cases: when to use Maps
Using the same shapes in all sequences

Well that one is quite easy, it's already like this by default!

By default, you have one Map in your project, Map 1. If you don't create another one, then all new
sequences will also use it. That means that your shapes will be the same in every sequence and any
change will be reflected.

Indeed, each time you edit a shape in a Map, the changes are applied in all sequences using the same
Map. That way, if you need to edit the position of a point because your projector has moved, no need to
do it in each and every sequence!
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Using different shapes in different sequences

The number of Maps you can create in a project is not limited, which means you'll be able to create as
many drawings as you need. You could have a different one in each sequence or reuse the same a few
times for example.

Using a slightly different drawing in different sequences

As you might have understood from the previous paragraphs, Maps are kind of all or nothing. You can't
have some shapes in common and some not if you are using different Maps. 

But sometimes you might need to use almost all of the same shapes in different sequences, with just
one or two exceptions, like add a circle here or there let's say. You could always just copy/paste in place
([CTRL/Cmd + Shift + V]) some shapes from one Map to another, but they won't be linked, so if you need
to change something, you'll have to reproduce it in both maps.

One tip might be useful to know if you want to have slight exceptions: the hide/show state is
independent from Maps! Indeed, only geometric features are saved in Maps (coordinates of vertices,
locked or not, masked or not, name), but not if it is hidden or not.

Let's rephrase with an example: you could keep the same Map in all sequences, but simply hide a shape
here or there in specific sequences when you need it, and it would only affect the current sequence. That
way, you wouldn't lose the link between the position of all shapes, but you'd have different drawings.
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6. The Creative Tools

The creative tools are there to help you during the creation process. Among other things, they will help
you create a drawing from a picture, or adjust your mapping precisely on a volume.

6.1. The Magnet
The Magnet is a tool that allows you to place your shapes without unwanted space between them. It will
help you position your shapes by creating an attraction or snapping effect when you move a point close
to another one or the canvas border.

Enabling the Magnet
This tool can be toggled ON and OFF from the toolbar or with the shortcut [CTRL/Cmd + M].

Magnetizing points together
Merging points

When the magnet mode is activated, you’ll see that when you drag a shape next to another one, a blue
area will appear if two vertices (centers included) are close to each other. Once you release your mouse
button, these points will be linked.

This whole process also works when you only move one point and not the whole shape, or when you
position a shape that you just dragged from the toolbar.

As you can see, if you move one of these points now, the other one will move with it (even when the
Magnet is OFF).

Note: be aware that the the points are actually merged, so if you delete one or its shape, the other will
also disappear (except if the shape has less than four points.)

Separating merged points

On the other hand, the shapes always stay independent, so if you move one whole shape, the other one
won’t be affected and the link between the vertices will be broken.
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Note: the Magnet doesn't have to be ON to separate points.

 

Snapping points to the canvas or a screen outline
When the Magnet is enabled, you also have the possibility to snap points easily on the 4 sides of the
canvas or a screen if View → Show Screens is enabled.

Similarly to when you merge points together, you'll see a blue indicator that tells you when to drop your
selection so that it is placed precisely. However, in this case it works more like a "snap", i.e. you'll feel a
kind of resistance when you drag points close to the outline.

6.2. The Background Image
It is possible to import an image and use it as the background of your canvas. It is especially useful if you
have an idea of where your projector will be: take a snapshot of your structure from the position of your
projector and use it as a background reference. Then, just place your shapes precisely on the picture of
your volume. That way, you can prepare your mapping remotely, without having to be on the site of your
performance.
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Displaying the background
In order to activate the display of a background, select View → Show Image. You’ll see a default picture
appear in your work area. Simply untick the option when you want to turn it off.

Note: the background image won’t appear in your projection, this is only for creation purposes. If you
want to add an image in your projection, you need to use a player.

Background Settings
You probably want to use your own picture and not the default one. Here is the procedure to select a
picture from your computer files:

1. First, go to View → Image Settings...

. A window with several parameters will appear.

2. Click on “Choose file” 

to browse your folders and select the desired picture from your computer. Once you have selected a
picture, you should see its filename next to the “Choose file” button and a preview of it just above. 

Note: you can use .JPEG (or .JPG), .PNG and .BMP files for this feature. Also, the transparency in
.PNG files is supported.

3. The preview in the settings window shows you how the picture will be displayed in your canvas. You
can adjust its size and position. There are four options:

• Fit to width resolution: this will adjust the size of your picture so that its width is the same as your
projection area, all the while keeping its aspect ratio. The picture will also be centered. If you change
the resolution of your canvas, the size of the background picture will automatically be updated in
order to fit the new width.

• Fit to height resolution: this will adjust the size of your picture so that its height is the same as that
of your projection area, all the while keeping its aspect ratio. The picture will also be centered.

If you change the resolution of your canvas, the size of the background picture will automatically be
updated in order to fit the new height.

• Expand: this will adjust the size of your picture so that it fills your projection area completely,
regardless of its original aspect ratio. If you change the resolution of your canvas, the size of the
background picture will automatically be updated in order to fit the new width and height.

• Custom: if you select this option, you’ll be able to enter a specific size (width and height) and a
specific position (X and Y coordinates) for your picture. By default, the aspect ratio is preserved
when you change the size of your picture. If you want to remove this constraint, click on the links 
 button. Note that if you change the resolution of your canvas, the size of the background picture will
remain unchanged.
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4. Click on “Ok” to apply your changes, or “Cancel” to exit the window without saving them.

6.3. The Cursor
When activated, the Cursor tool allows you to see the pointer of your mouse with a crosshair on the
output, so that you can know where it is without looking at your screen. That way, you can draw while
looking directly at the projection.

Displaying the Cursor
This tool can be toggled ON and OFF with the crosshair icon in the toolbar.

Customizing the Cursor
You can alter the appearance of the Cursor in Edit → Preferences... → Output → Cursor.

By default, the cursor is white, but you can change its color, as well as its thickness and opacity.
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7. Managing Group Effects

Learn about the different effects you can add and customize in your shapes, from the built-
in library of group effects.

7.1. Adding Group effects in Faces

The panel accessible from the 3 lavender icons   in the right toolbar lets you access the

different Group effects of Proxima. "Group effects" means that they apply to all the faces in a specific
group.

Check out the video tutorial below, or follow the written instructions after it.

https://youtu.be/xKP4v516VU0

Activating group effects
The Group Effects panel allows you to activate effects and adjust all their parameters.

Effects are organized in tabs. On each tab, you’ll find a switch to activate the corresponding effect and all
its parameters listed below.

Note: you can also double-click on a tab to quickly switch the corresponding effect ON/OFF.

When you turn on an effect with the switch the first time, it turns ON with basic default values for its
parameters. You can use the lightning icon  to access a list of Presets that allow you to activate the
effect with a full set of parameter values. There are some built-in Proxima choices or you can even save &
load your favorites.

Note: by default, a white Border effect is on in every new group, so that you can see your shapes in the
projection when you draw.

What are groups and how to create them
Faces are contained in groups, so there always has to be at least one group. By default, when you create
a new project, you’ll notice a white “Group 1” in the Layers panel. If you activate a group effect then, it will
apply to all faces, as seen in the previous GIF. 

To create a new group, simply click on the   button at the top of the Layers panel. You can have 1 to 30
groups in a sequence.
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Moving faces to a group
By default, faces are added to the active group when you create them (the one with the light
gray background in the list). There are different methods to change this group assignment and move
faces to other groups.

Once a face is moved to a different group, its color in the work area switches to that of its new group. To
move faces to a group you can either:

In the layers list, simply drag & drop a selection of shapes to the desired group;

Select shapes and use the Add to group + button on the desired group in the layers list (up to HM
2.5);

Or use the “Move to” item in the right-click context menu of a selection of shapes. This way, you can
send the shapes to an existing group or to a new group. (In this last case, it is the same as clicking

on the Add Group   button with a selection.)

Note: players can also be added to groups, but it doesn’t serve the same function. Read the 👉display

settings [p.73] tutorial for more info.

Selecting a group and making it active
When you activate a group effect or play with its settings, all changes are applied to the currently active
group. You can see which group is active in the layer list because of its lighter color and colored border. It
is also indicated by a label at the top of the Group Effects panel.

Here, the blue group named “Door” is active in the layers panel so it is editable in the group effects panel.

To make a group active, you can either:

Click on it in the layer list ;

Or select a shape it contains, either in the layer list or the work area.

Note: when you deselect all shapes, the active group stays the same until you select another one. Also,
when you make a selection of shapes from different groups, the editable group stays the same.
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Now, you can apply different effects in different parts of your mapping by changing the active group:

Note: there has to be one active group at all times. There also cannot be multiple active groups at the
same time, so you can’t select multiple groups at once. 

Arranging groups
The order of the groups in the layer list has an importance, as the top group is the one rendered at the
front in the projection. To arrange groups you can either:

Drag & drop them in the list;

Use the Move Group Forward   and Move Group Backward   buttons at the top of the panel;

Or use the “Arrange” actions in the options menu of a group.

Group options
Group effect parameters

As you can see in the tabs, group effects have a lot of parameters. The best advice we can give you is to
try and play with them: it’s easy to get entirely new visuals by combining effects and tinkering with their

settings. You can even make them 👉tempo or audio-reactive ! [p.84]

7.2. Effect parameters & LFOs
There are new effect parameters and new oscillators called LFOs that will make your parameters vary
automatically with fancy functions and settings, go check them out!

You'll find them on a dropdown menu on many parameters:

There are three main categories of variation: Fixed (no variation), LFO (variation according to the
tempo), Audio (variation according to sound).
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Let's see a rundown of the different variation modes in each category. We'll demonstrate them using a
simple Filling - Special - Inside effect and the variation will be on the Fill Percentage parameter, which
has a value range of 0 to 100. 

Note: to better illustrate the variation of the LFO functions, the variation stops for a bit before restarting
in the GIFs below. In reality, the variation loops seamlessly without pause.

  Fixed Value:
There is no variation of the parameter. You can only set a fixed value, and it will not vary.

Here, the Fill Percentage is set to 50.

  Sine (LFO): 
The value of the parameter varies in a loop, according to a sinusoidal function. You can set the min and
max value of the variation range.

Here, the Fill Percentage varies between 0 and 100.

  Triangle (LFO):
The value of the parameter varies in a loop, according to a triangular function. You can set the min and
max value of the variation range.

Here, the Fill Percentage varies between 0 and 100.
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  Trapezoid (LFO):
The value of the parameter varies in a loop, according to a trapezoidal function. You can set the min and
max value of the variation range.

Here, the Fill Percentage varies between 0 and 100.

  Square (LFO):
The value of the parameter alternates between two values. It jumps from the min value to the max value
you set, in a loop.

Here, the Fill Percentage switches between 0 and 100.

  Saw Up (LFO): 
The value of the parameter follows a linear function that goes from the min value to the max value you
set. Once it reaches the max value, it starts back from the min value in a loop.

Here, the Fill Percentage goes from 0 to 100.
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  Saw Down (LFO):
The value of the parameter follows a linear function that goes from the max value to the min value you
set. Once it reaches the min value, it starts back from the min value in a loop.

Here, the Fill Percentage goes from 100 to 0.

  Noise (LFO): 
The value of the parameter varies randomly. You can set the min and max value of the variation range.

Here, the Fill Percentage varies randomly between 0 and 100.

  Bass,    Mid,    High (Audio):
The value of the parameter varies according to sound. You can choose between three frequency bands
and set the min and max value of the variation range.

When the mean value of the frequency band increases, the value of the parameter will increase, and vice
versa.

7.3. Getting creative: playing with Group Effects & Shaders
and building a personal library
Where do I start? That might be a question you've asked yourself when trying to generate visuals for a
show. If you're new to the software, you may feel lost in all the creative possibilities and if you've been
here for a while you may feel like you're going in circles.

Whether you're a newbie or a veteran, this guide will provide you with creative tips on how to make the
most of the built-in creative resources to animate your mapping within Proxima.

Note: the following article focuses on creativity and content generation with the built-in effects of

Proxima, make sure you have covered the basics of « 👉Managing Group Effects [p.49] » and « 👉

Managing Group Properties [p.67] » before reading!
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Customizing Groups attributes

Playing with Group Effects
Let's start with Group Effects. Located on the right panel, they are divided in tabs and each have
many customizable parameters.

Start from scratch...
If you already know your way around the software and already know what you want, starting from a
clean base can be the way to go. If you're not familiar with Proxima, it can also be good to explore in
order to get to know each effect and their behavior.

The downside is that it can sometimes get time-consuming and you'll likely end up with more or less
the same combinations of effects after some time.

Start from a preset base...
To get you started quickly, we've integrated a few built-in presets on each effect tab and on group
effects as a whole. Presets allow you to load a set of pre-configured values quickly.

Use the lightning  icon next to the group name or an effect name to find the available presets for this
category. While browsing through a presets list, you'll get a live preview of the rendering on your
shapes, to help you choose easily!

Note: continue reading to learn how to get even more presets by saving your own and sharing with
others! 
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Start from a random base...
Looking for another source of inspiration? Try random values!

Use the dice   icon to affect all effects at once, or "Randomize values" from the presets list  of a
specific category to quickly generate random parameter values.

Obviously, as the result is by definition random, it won't always be to your liking, but don't hesitate to

spam the button! Even if the Random function is hidden in a menu for tabs, you can assign a 👉

Controls [p.99] [p.] key to be able to trigger it quickly. 

Note: full disclosure, the Random function is not a pure randomization of all values. For your comfort
we've added a few rules, so that you don't end up with crazy speeds or a fully transparent result for
instance.

...and make it match your identity
Whatever previous method(s) you've used, you can always go back to the result and customize it, the
built-in presets and random function are mostly there to get you started.

Want to make the variations even more immersive? Make some parameters 👉react to audio [p.84] [p.]!

You like an effect but it doesn't quite match the color identity of your show? Browse through the
effect categories and change the color that doesn't fit!
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Configuring Group Properties and playing with Shader effects
In addition to Group Effects, the Properties are another aspect of Groups that affect the visual aspect

of shapes. Check out the related article to learn about all 👉Group Properties [p.67].

Here we'll focus on one parameter section in particular, Shaders, as they are another quick and easy
way to generate new visuals from an existing base.

Apply Group shader(s) to your effects base
Go to the Properties panel of your Group on the left and click on the + sign of the Shaders section to
access the library and choose which shader(s) to apply: they'll work like filters on your existing
visuals. Once the choice is made, keep reading.

Repeat previous steps
Guess what, you can randomize shader parameter values!

Similarly to what we've seen with Group Effects earlier, use the random function for inspiration and
tinker with the values afterwards to make them perfect for you.

Saving favorites as presets for re-use
Well now that I've perfected one Group what do I do?

Saving custom presets
Once you have combination of parameters that you like, you can quickly save it as a new preset in
order to keep it ready if you need it later. Use the lightning  icon and click on "Save current values
as..." to create a new preset.

Once saved, it will appear in the presets list  with other built-in presets and will be available in all
other Proxima sessions on you server
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Organizing a personal library
Presets are already organized by their type, so that when you open a presets list you only see the
related presets (i.e. you won't end up with a Line preset in the Structure presets list).

But once you start creating your own presets, each list can become long pretty quick. That's why you
can use "/" in the name of a preset to store it in a subfolder and keep your library tidy.

Importing presets
Presets are stored as files in Documents/HeavyM/PresetsLibrary. Since you have access to the files,
you can rename and delete them directly from the file explorer/finder. But another great feature is
that you can copy/paste them!

Whether it is to transfer your own Presets library to another computer or to use the Presets library
shared by another user, simply paste them in their corresponding folder and you'll get access to them
in HeavyM.

Note: make sure to keep the base architecture of folders as it is so that lists from different categories
don't get mixed up!

Proxima Managing Group Effects

58 Jan, 11th 2024

file:///C:/Users/thier/Documents/SCENARIchain-desktop%206/~gens/Proxima2/Manuel%20Proxima/_EN_Proxima_userGuide.pub/guideP/co/_EN_Proxima_userGuide.html


Mix it up!
We've given you a few tips, now it's up to you to you to combine all these creative resources to create
crazy new visuals. Mix and match presets from different categories, share ideas with friends, add a touch
of random here and there, reset an effect when it goes wrong... 

The possibilities are virtually endless!

Saving Group presets from combinations you like
While we've mentioned presets for Group Effects and Group Properties, you can combine both in a
single Group preset. As for other types, use the lighting  icon of a Group in the Layers list:

How to go further
That was a lot of info right? Well I'm sorry (not sorry) to say that we've only scratched the surface of
the creative possibilities of Proxima. Without mentioning videos or external assets, look for Master
Shaders and Generative Shaders in Sources for other nice built-in resources.

Spoiler: the Random function and Presets are also avalaible on these shaders (and Transitions too!)

7.4. Using the Center to control the perspective of effects
The Center is the + point that you see when you select a face. It can be used as the origin point in many
Group effects and helps you add perspective to your mapping.

What's the point?
The Center is a geometric property of a face. It's a point, and while it doesn't exactly serve the same
purpose as other regular vertices, it behaves similarly in the canvas.

It is used to change the vanishing point of compatible Group effects, thus letting you adjust the
perspective illusion. 

Each face has a unique Center, it is the same in all sequences where the face is used (like other

geometric features, it is saved in 👉Maps [p.32]).

Note: the Center of a face cannot be deleted.
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Using the center instead of the default origin
To see the impact of the Center, you first need to toggle a compatible effect and set "Center" as
the Origin point in the Path category. 

Now, when you move the Center point, you'll see the origin adapt to it. Since the Center of a face actually
coincides with its center of gravity by default, you also have to move it first to see any change (more on
the possibilities in the next paragraphs.)

The compatible effects are:
all Outline effects, Rotation, Inside, Outside, Hypnotic, Mosaic, Radial Glow, Round Trip and Elastic.

Note: if you don't want your effects to be rendered outside of the Group outline, check "Clip the overflow
of Group effects" in Edit → Preferences... → Output → Overflow. It'll give you the following appearance:

Placing the Center of a face
By default, Centers appear when you select their faces. But you can also make them be visible all the
time by enabling "Show All Centers" from the View menu.

Adjusting its position from the Canvas
Like any other regular vertex, you can move the Center by simply selecting it and dragging it with
your mouse pointer or using the arrow keys.

If you enable the Magnet Snap  , you can even snap Centers together. That way they'll coincide

and be considered as the same point when you edit their Properties. (To unsnap, simply drag one on
the shapes away.)
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Adjusting coordinates from the Properties
Speaking of Properties, you can also edit the position of a Center from the Properties panel on the
left.

Indeed, when a Center is selected (or its associated face), its X and Y coordinates are displayed.

Note: the (0,0) origin of the coordinates is the top-left corner of the Canvas.

Resetting its position
If you wish to reset the position of a Center so that it coincides with the center of gravity again, you
can do so with the button in the Properties panel, or with the option in the "Transform" category in the
right-click menu.

Note: when a Center is in its default position, it is not affected by shape transformations until you
edit it manually, i.e. it stays stuck to the center of gravity. 

Animating the position of a Center
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Using LFOs to automate the variation of a coordinate
The coordinates of a center can be animated with automatic variators! As you can see in the
Properties, each coordinate has an LFO selector, like you might have encountered on some Group
effect parameters. 

Simply select a type of variation and adjust the min and max limits of the range in which center will
vary.

Using Controls to animate coordinates remotely
The coordinate spinboxes and variation type selector are learnable elements, i.e. you can assign
them a Keyboard or OSC control.

Note: at the moment, the controls you assign will only affect the selected center (or centers if they
are snapped together) regardless of the sequence or map you're in: you can't target a specific center.

7.5. Group effects glossary

This glossary aims to present all the effects type you can find in the  Group Effects panel. Effects

are organized in tabs in the panel and for the purpose of clarity in this article we've also separated them
in 3 categories, according to their type: Outline, Filling and Transformation.

Note: Group effects are assigned to groups and only apply to the faces they contain, not your whole
output.

Outline effects
The first type of group effects animate the outline of the faces you have drawn. By default, a static white
border effect is activated when you create new group, so that you can see the face appear in your
projection when you draw your mapping.

The two Outline tabs are Border and Line. You can activate one effect from each tab at the same time. 

  Border
The effects from this tab draw and animate the edges of your shapes. There are four of them. You
can choose between:

  Basic: displays all the edges of faces.

  Blinking: alternates between showing and hiding the edges of faces, which makes it seems like
it’s blinking.

 Half: only shows one out of two edges of each of the faces at the same time. Alternates between
all edges.
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  Quarter: only shows one out of four edges of each of the faces at the same time. Alternates
between all edges, clockwise.

All these effects are in a basic configuration by default, but they have many parameters that you can
play with, here are examples of what you can achieve in just a few seconds:

  Line
The effects from this tab draw and animate lines along the edges of your faces. There are three of
them. You can choose between:

  Normal: displays a line moving along the border of faces.

  Boomerang: displays an animated line on each edge of the faces. Each line moves back and forth
between the ends of the edge it’s on in a sort of bouncy motion.

  Yoyo: displays an animated line on each edge of the faces. Each line is tied to one end of the
edge it’s on and extends until it reaches the other end, then retracts completely and so on. Kind of
like a yoyo that goes down till the end of the thread, then comes back up.

All these effects are in a basic configuration by default, but they have many parameters that you can
play with, here are examples of what you can achieve in just a few seconds:

Filling effects
The second type of group effects animate the filling of the faces you have drawn. By default, no filling is
activated.

The three Filling tabs are Color, Special and Snake. You can activate one effect from each tab at the
same time. 

  Color
The effects from this tab animate the filling of your faces with color. There are three of them. You can
choose between:

  Plain Color: fills faces with a plain color (or an animation of plain colors).

  Linear Gradient: fills faces with a fixed or animated linear gradient of two colors. The progressive

transition between the colors follows a straight line.

  Radial Gradient: fills faces with a fixed radial gradient of two colors. The progressive transition
between the colors radiates from the center of the faces.

  Angular Gradient: fills faces with a fixed or animated angular gradient (also known as conic
gradient) of two colors. The progressive transition between the colors seems like it is rotating around
the center of the faces.
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  Diamond Gradient: fills faces with a fixed or animated diamond gradient of two colors. The
progressive transition between the colors, well, is diamond-shaped.

  Random Color: fills faces with plain colors that alternate randomly.

All these effects are in a basic configuration by default, but they have many parameters that you can
play with, here are examples of what you can achieve in just a few seconds:

  Special
The effects from this tab add animated colored geometric elements inside your faces. There are ten
of them. You can choose between:

  Inside: fills faces with an animated tile that grows from their center towards their borders.

  Outside: fills faces with an animated tile that grows from their borders towards their center.

  Corner: fills faces with animated tiles that grow from their corners towards their middle.

  Swipe (solo): fills faces with an animated tile that grows like it has been swiped from one side.
Each shape has its own tile.

  Swipe (global): fills faces with an animated tile that grows like it has been swiped from one side.
There’s one tile that covers all shapes of the group.

  Stairs: fills faces with an animated tile that looks like stairs.

  Hypnotic: fills faces with a hypnotizing animation, with a motion that originates from their center.

  Stripes: fills faces with animated stripes.

  Double Stripes: fills faces with two layers of animated stripes.

  Mosaic: creates a mosaic inside faces, with a different opacity for each tile.

Note: the animated geometric elements created by these effects are placed above the effects in the
Color category in your filling. That means that if you have a Color effect on and you put
a Special effect with a slightly transparent color setting, you’ll start to see the Color effect behind.

All these effects are in a basic configuration by default, but they have many parameters that you can
play with, here are examples of what you can achieve in just a few seconds:

  Snake
There’s only one effect in this tab, indeed the snake is an effect on its own. It creates an animation
that lights up the fillings in your faces one by one, following a path that you define.

You can choose to apply it on the Color, the Special, or both at the same time. That means that if you
don’t have at least a Color or Special effect on, it won’t show anything.
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Here’s how to set up the path of your snake:

1. In the corresponding section of the effects panel, click on “Start drawing”.

2. You’ll see that your cursor turns into a cross and you can now draw a line by clicking and
dragging the cursor in your work area. Every time your cursor goes through a face, the face will
turn white, which means it has been added to the snake’s path.

3. Release your mouse button when you are satisfied with the path you have drawn.

4. You’ll notice that once you start drawing, the “Start drawing” button turns into “Validate path”

. Click on it once you’ve finished drawing to validate the path.

Note: when you are in the drawing phase, clicking anywhere on your work area before validating
will erase the current path and you’ll have to start a new one!

Once your path has been defined, know that you can always go back and edit it later by starting the
previous process again.

Here are examples of the Snake on Color and Special effects:

Transformation
The third and last type of group effects animate the faces you have drawn and transform their form. By
default, no transformation is applied.

The two Transformation tabs are Rotation and Structure. You can activate one effect from each tab at
the same time.

 Rotation
There’s only one effect in this tab, indeed the rotation is an effect on its own. It will allow you to
animate your faces in a 2D or 3D rotational motion, along the X, Y and Z axis. You can combine the 3
axis of rotation.

It affects the content of your faces: when you apply the rotation effect to a group of faces, the
Outline, Filling and Structure effects they contain will follow the circular motion.

Here are examples of rotations on Color and Special effects:

 Structure
The effects from this tab create visual effects with motion from your faces. They are a bit difficult to

describe with words, so we’ll let you guess from the icons! You can choose between 6 of them:

  Radial Glow

  Wire Frame

  Round Trip
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  Origami

  Strokes

  Elastic

Note: these visual effects are generated from the outline of your faces, but they don’t depend on the
Outline effects. The structure effects are completely independent, you can activate them and see
their visual animations without having any other effect on.

All these effects are in a basic configuration by default, but they have many parameters that you can
play with, here are examples of what you can achieve in just a few seconds:
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8. Managing Group Properties

8.1. Overview of group properties & options
Located on the left of the interface, the Properties panel gives you access to additional features related
to the selected object. If no shape is selected, this panel displays the Properties of the active group. You
can click on the header of a group to make it active and thus display its Properties.

These options are in addition to the quick group actions that you can already access from the Layers
panel.

Note: multigroup-selection is not handled (yet), so you can only edit the properties of one group at a time.

Group Properties
Here are the group features you'll find in the panel:

Group properties Presets: click on the lightning icon  to unfold the list of available group properties
Presets and quickly apply a previously saved set of parameters. Presets include the values of all
properties listed below.

Blend Mode: blend modes define how groups are mixed together in the rendering. The list is the
same as the one you can access from the  icon in the Layers panel. Hover over each item in
the list to see a preview of the result and click to choose one.

Opacity: this parameter controls the opacity of the whole group as one layer. You can assign a 👉

Control [p.99] to its value to change it remotely.

Shaders: you can add Postprocessing shader effects to groups. They are the same shaders that you
can add on Players, Sequences and Master.

Overflow clipping: you can control the overflow of effects outside of shapes. Choose a default
setting for each type of effect in the Preferences (Edit → Preferences... → Rendering →

Proxima Managing Group Properties

Jan, 11th 2024 67



Overflow) and overwrite it for individual objects. Here, you can choose to clip the overflow of Group
Effects and Group Shaders (by the outline of the group). Here's the same example with different
combinations of options:

 → Nothing clipped

 → Effects clipped

 →Shaders clipped

MSAA algorithm: this attribute affects the quality and efficiency of antialiasing around the egdes of
overlapping groups. Indeed, MSAA, which you can toggle in the Preferences (Edit → Preferences...
→ Rendering → Antialiasing), reduces the pixelated aspect of the edges of shapes but it also
produces a thin dark border around the outline of groups. Choose "Accurate" on top groups to
remove this artefact, or "Fast" for an optimized mode.
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Group options
Some additional group options are hidden from the Properties but you can access them from the options
menu  in the Layers panel. 

Here are some notable options:

Rename: allows you to rename the group. You can also directly double-click on its name in the layer
list.

Color: allows you to change the color of the group in the work area. You can also directly click on its
color icon in the list. This will unfold a palette of 30 colors to choose from. (It doesn’t affect anything
in the output.)

Copy Group Effects to: gives you the possibility to quickly copy its Group Effects and their
parameters and paste them to another group.

Reset Group Effects: gives you the possibility to quickly reset its Group Effects and their parameters
to the default state of only a thin white Border. Use the options menu in the header of the Layers
Panel to access the bulk option "Reset All Group Effects".

8.2. Mixing groups with blend modes
The hierarchy in the Layers panel follows a simple rule: in the Canvas, what's above in the Layers tree is
displayed in front of what's below. When you add a shape, it covers the shapes that are behind, so by
default you'll only see through it if your top object has some kind of transparency.

I say "by default" because how groups are mixed together depends on the Blend Mode that is applied.  

What are blend modes?
You might have already heard about Blend Modes as they are quite commonly found on digital editing or
compositing apps. The Blend Mode of a layer determines how it is blended with the layers below. 

Blend modes are actually a bunch of formulas that take each pixel of the blend layer and each pixel
directly below, applies some math operations and gives you a result. Each blend mode uses a different
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formula, that's why you get a different mix with each one. We won't get into details about the formulas, as
it would probably take me a whole year to write, but feel free to do your own research, there are plenty of
resources on the subject on the internet.

In Proxima, blend modes are applied on groups. The "Normal" blend mode is the default one that we
described and that is pictured in the introduction: each group obscures the groups below it.

How to use blend modes in Proxima
There are 26 blend modes to choose from. To change the blend mode of a group use its drop-down menu
in the Layers panel, accessible with this button   and simply choose the one you want from the list.
When you hover over an item of the list, its effect is previewed in the rendering.

Once you click on a mode, it'll be applied and you'll see the result of the new mix instantly. Remember
that a blend mode should be applied to a top layer. And of course, each group can have its own blend
mode so you combine them and reach a very complex composition.

Note: the blend mode button has two states:   if the "Normal" blend mode is applied,   if it's any other
mode.

The different types of blend modes
As mentioned before, there are 26 blend modes to choose from, each with a different formula. Depending
on the content you blend, they'll give very different mixes and their name won't help you much usually, so
it can be hard to guess the result at first. The best way to discover them is to try by yourself!

One thing that can help you though, is how the blend modes are ordered. You might have noticed in the
list that they are categorized. Indeed, some blend modes share some similarities in their behavior:

Normal modes (Normal): we've already talked about this one, it's on its own and is the default one.

Darken modes (Darken, Multiply, Color Burn, Linear Burn): as you can guess, there's something
about darkening the rendering here. They make white disappear on the blended group.

Lighten modes (Lightening, Screen, Color Dodge, Linear Dodge (add)): as you can guess, there's
something about lightening the rendering here. They make black disappear on the blended group.

Contrast modes (Overlay, Soft Light, Hard Light, Vivid Light, Linear Light, Pin Light, Hard Mix): these
ones both darken and lighten at the same time, which in turn enhances the contrast.

Inversion/Cancellation or Comparative modes (Difference, Exclusion, Subtract, Divide, Invert,
InvertRGB): these work on the similarities or differences of the blended and base groups. Well, just
try them and see what happens.

HSL or Composite group (Hue, Saturation, Color, Luminosity): these play on different color
properties, as implied by their names.
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Blend mode examples
Well, I think that's enough blabla for this article. Let's just see what kind of stuff you can make with these.
Instead of describing them one by one, here are a few examples of blend modes in use in Proxima:

Multiply <3

Note: Multiply is a quite commonly used. As seen above one of its great use case in Proxima is to put
a texture in a group with the Multiply blend mode and in a base group below put white group effects
on shapes. The result will look like the texture is printed on the effects!

Screen

Overlay
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Exclusion
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9. Managing Multimedia Content

Learn about the different types of multimedia content you can display in Proxima and how to control
their playback.

9.1. Adding & displaying multimedia content

In Proxima, in addition to the built-in library of visual effects, you can play your own external
content. These medias are displayed in shapes called players.

Players can support these types: Photos, Videos, GIFs, Webcam streams, 👉NDI streams [p.132],
Generative Shaders, Text.

Inserting medias in your project
What are "Sources" and "Medias"?

Your medias are stored in the Source Bin and you can then choose where to display them, they are not
contained in a specific shape. In addition, the bin is common to all sequences throughout your project.

The process works like this:

You store your Medias in Sources, of which there are two types: Solo Sources (1 media) and Playlist
Sources (multiple medias that can be played successively).

You then connect these Sources to all the 👉players [p.32] you want. All players associated with the

same source will be in sync as they are displaying content from the same place.

Adding content to the Source Bin

The 👉Source bin [p.13] is located on the right of the interface. To add some content inside, you can simply
drag and drop videos, photos, GIFs in it, or use the menu at the top of the panel to select a type.
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Displaying sources in players
Connecting sources to players

Once you've added your sources in the bin, you can then choose the player(s) in which to display them.
This means that you can play the same source in different player areas at the same time and control it
from one place only!

To display a source in a player, select the player and you'll see a target button appear on the thumbnails
in the bin, whether they are Solo or Playlist sources. Just click on the source you wish to connect, and it's
done!

Note: for videos, GIFs and images, you can also directly drag & drop the files in the canvas. If you drop
one file, it'll create a player and a Solo source linked to it. If you drop multiple files, it'll create a player and
associate it with a Playlist with all the medias in it!

Choosing a display mode

By default, sources are displayed in the whole rectangle area of a player. But you might want to show
them in another polygonal shape, or even a whole drawing in multiple parts. Well you can do so by using
faces as masking areas. 

Indeed, players have two display modes : 

   Unclipped (display in full) : the content is displayed in the whole area of the player. It is the
default option.

   Clipped (display in group faces) : the content is clipped by the faces of the group that the player
belongs to. It means that it is displayed only in the parts of the player area that are over/under a face
from the same group.

You can switch modes for each player, either from the corresponding icon in the Layers panel, or by using
the dropdown in the Properties of a specific player.

Arranging players in the layer panel

The position of a player in the layer list is important, especially if you intend to combine it with group
effects. As mentioned previously, the group in which a player is placed already has an impact if you use
the « Clipped » display mode.
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But even within a group, the order can be important, as the content of the player, no matter which display
mode is used, will always be displayed in front of group effects from faces below it in the layer tree, and
behind faces above it.

Note: generally speaking, the order of shapes in the layer tree impacts on the rendering in a similar way: a
shape is displayed in front of the ones below it in the pile, and behind the ones above it.

9.2. Using the Slice Selector to crop the input of a player
While masking is a useful tool if you need fancy shapes, in that case the Player still fits the full size
media inside its rectangular area. There are cases where you might want to crop the input before it is
sent to the Player. That's when the Slice Selector module comes in handy.

In this article, we'll describe the behavior of the Slice Selector and then illustrate its application in a cake
mapping use case.

How does it work?
Where to find it

A slice is a property of a player, not sources or medias. It is independent from the linked content. 

You can open the Slice Selector of a player by selecting it and clicking on "Enter slice selector" under
the "Crop" section of its Poperties.

Note: there can be one slice per player.

Overview of the Slice Selector window

There can be one slice per player. A slice is a non-destructive way to crop content, it can be edited
indefinitely.
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Here's an overview of the selector window:

In the center of the Slice Selector, you get a still frame of the content displayed inside the player and
the name and resolution of the media that is playing are indicated above. If nothing is attached to
the player the moment you open the Slice Selector, you'll see the 1920x1080 default checkerboard
card seen in the previous screenshot and you can still create a slice.

On this frame, you'll find the crop zone, the rectangular area defined by the four yellow handles. It
represents the slice and its resolution (in pixels) and coordinates (in pixels too, relative to the top left
corners of the frame and the zone). 

You can navigate the creation area with common Proxima controls: zoom in/out with the buttons on
the bottom right corner or with your mousewheel ; move around by pressing your mousewheel or
with [Space] + drag.

Creating a slice

To create a slice, simply:

1. Set its size by dragging the yellow handles to define the limits of the crop zone or use the input
fields below the frame to enter precise values, either in percentage or pixels (more on that in the next
section).

2. Set its position by dragging the crop zone, or using the arrow keys on your keyboard.

3. Click on "Create".

That's it! If you need to edit the slice, simply enter the slice selector of the player, make your changes and
click on "Create" to apply them.

Behavior with Medias

A slice is not directly linked to a Source, so it's not relative to any Media. Actually, any type of Media can
be cropped, even with different sizes. The slice just creates a texture with the same proportions relative
to the resolution of the current media.

As seen in the overview, the size of the slice is given in percent and pixels. You'll notice that the values in
percent never change, no matter which media is currently playing. That's because it doesn't depend on
the resolution of the current media (contrary to the pixel size, that is just given has an indication and is
converted from the percentage value). Same with the coordinates, they're proportional. Here's an
example:

You create a slice that takes 50% of the width and 50% of the height and place it on the top right corner :
no matter which type of media is playing or its resolution, this player will always display the top right
quarter of the texture. For instance if it's a 1920x1080 video, the slice will cover 960x540px and be placed
at X=960 ; Y=0. For a 500x500 shader, those values will represent 250x250px and X=250 ; Y=250.

Behavior with Maps
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As mentioned before, a slice is considered a geometric property of a player. Hence, it is linked to the
shape and will be the same throughout all sequences using the same Map.

Cake mapping example
Here's an example of how the Slice Selector can make your life easier. Let's map a single video loop

on a dummy cake for a wedding.

1. We've added a photo of the cake from the point of view of the projector in the background (View →
Image Settings...) to help us draw.

2. We create and adjust one player on each part of the cake where we want to see the loop.

3. Our video is 1920x1080. We've created an image template of the same size to help us define each of
the 8 slices.

4. Let's attach it to a first player. We see that, as expected, the image fills the shape.
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5. We can create the slice in its Slice Selector by adjusting the crop zone to the corresponding color
block in the template. Here, we know that it's going to be 860x270 so we can directly use the pixel
input fields.

Here's the result after hitting "Create":

6. After repeating steps 4 and 5 for each player, we get this:

7. Now that each slice is properly adjusted, we can just change the content and link our video.
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That's it! The same single video is attached to all the players, so playback is perfectly synchronized
between all slices.

9.3. Controlling the playback of medias
Whether you intend to fully automate your project, or play it by ear in a live setting, there are many
settings that can help you control the playback of multimedia content in Proxima.

Know that the settings described here are not only useful for videos, that have play/pause buttons, but
also for multimedia content with no progress bar like text or images. Indeed, they will let you trigger your
medias at a specific time or help you play them successively for example.

All these concepts can be difficult to grasp at first, especially with written instructions. So bear with us
and try to test the different settings in one of your projects to illustrate! 

Setting up how sources are triggered in parallel with the sequence timeline
One bin to rule them all

The 👉Sources Bin [p.13] is common to all sequences, it is the same throughout all your project. This

means that all media playback is controlled from this one place, no matter which sequence you're in.

In a previous article, you've learnt how to connect a source to one or multiple players, to display its
content in sync in different areas of one sequence. 
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In addition, one single player can hold a different source in each sequence. Indeed, sources are
independent from sequences, so if you want the same one to be played in multiple sequences, you have
to link it in each one (still with the same target icon). You can also display the same source in a different
zone each time!

Understanding how sources relate to the timeline

As you've probably noticed, once you attach a source to a player, it starts playing right away. By default,
sources play in a loop in all sequences where they are displayed from the moment they are attached,
independentely of sequence changes.

For example, if you attach a video in Seq 1 and Seq 2, it starts playing when you attach it and then it
keeps going whether you select or play Seq 1 or 2. If at some point you click on Seq 3, where the source
is not displayed, it'll simply be paused in the background, and will resume playing once Seq 1 or 2 is
selected/played again.

That's how it will always work when your Sequencer is stopped. If you only use medias with no apparent
beginning/end, like images or video loops, this might be sufficient. But if you want to automate your
show a little bit and define start/end cues for your multimedia content, you need to make use of the
Sequencer.

 

Controlling when sources are played in the timeline

Each source, whether Solo or Playlist, has a setting called a Playback Mode, which lets you set how it
should be triggered by the Sequencer timeline. Find it by opening the settings of a source with the cog
icon on its thumbnail or at the top of a playlist. 
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The Playback mode affects how the source behaves when the sequencer is playing and the sequence
changes. 

Here are the different possibilities:

Normal: source playback is independent from sequence changes, i.e. when a new sequence starts,
the source keeps playing unaffected (or stays paused/stopped if it's not playing). In this mode, you
have an additional option "Restart with seq" that lets you set one restart trigger on a specific
sequence.

Restart: sources are rewound at each sequence change, i.e. when a new sequence starts, the source
restarts playing from its beginning. If the source is a Playlist, it starts back from the beginning of its
first media.

Skip (only for playlists): source playback skips to the next media at each sequence change, i.e. when
a new sequence starts, the source starts playing the next media in the playlist.

Note: remember, when the sequencer is stopped, sources behave as if they were in Normal mode.

Setting up how medias loop
The first part of this article was about controlling the trigger of a Source with the Sequencer timeline.
Now, you might also need to control the playback of the media(s) inside a source, or not even need to use
multiple sequences. This section is all about controlling the playback of a media once it has finished
playing once. In short, part 1 was about controlling the start, and part 2 concentrates on the end!

The end behaviour is determined by the loop setting of each media in a source. Find it by opening the
settings of a media with the cog icon on its thumbnail.

Depending on the type of media, there are different settings. Here are the different options you can
encounter:

 Infinite loop: the media will loop infinitely. This is the default loop mode for a media in
a Solo source.

 Pause at the end: the media will play once and pause at the last frame.

 Stop at the end: the media will play once and stop at the end (the player will be transparent then).

 Auto-follow (only for playlists): the media will play once and then trigger the next one in the
playlist when it reaches its end. This is the default loop mode for medias in Playlist sources, it's what
makes the playlist work and the medias in it play successively.

Note: one of the main advantages of playlists, is that you can play the media inside in succession
automatically (like a playlist, duh) with the auto-follow setting. But you can still use other loop modes!
For example, you can put all medias inside a playlist on infinite loop to simply use a playlist as a media
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bin linked to specific players, for live VJing for example. To trigger a media, simply double-click on it with

your pointer, or set up an assignment with an 👉external controller [p.99].

9.4. Adding effects on players
There are multiple ways to add effects on top of the content you display in players. You can combine

them with 👉group effects in faces [p.73] or example, to overlay geometric patterns on top of your videos.
Players are also affected by the effects you put on sequences, as they affect the whole output.

But one solution is especially made for this: you can directly put shaders effects on players and they will
alter any content that's displayed inside of it.

Using post-processing effects on players

The effects that can be added on players are ISF post-processing shaders. Proxima
contains a built-in library of these.

Adding shaders on a player
To add an effect on a player:

1. Select the player.

2. Go to its Properties on the left of the interface.

3. Click on the + icon next to "Effects".

4. Select an effect in the shaders library and double-click on it or use the "Open" button.

Note: you can add as many shaders as you want on a single player and even add the same effect
multiple times.

Managing shader settings
Once you've added an effect, it directly affects your player, but you can disable it with the switch next
to the effect name. It can be useful to toggle them ON/OFF when you want to try different
combinations.

In addition, shaders can have parameters, so you can customize their effect! Most of the shaders
included in Proxima have at least one.

You can see and customize them by clicking on the cog icon next to the effect name. Most of the

parameters can even be animated with 👉variators [p.49], as you would do for group effect parameters.
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Note: use the lightning icon  at the top right of the parameters panel to quickly load a Preset of
values for this shader or save a new one with a combination of parameters you like.

 

Adding effects to the library
In addition to the built-in effects, you can add your own shaders. To do so, simply open the library again
and head over to the tab called "My Shaders".

There, you can browse your files and import .fs shaders. On players, shaders added to the library can only
be Post-Processing ISF shaders with a maximum of 1 input image.

To find these, you can look on websites like this one, by the creators of the ISF

standard: editor.isf.video[https://editor.isf.video/]... Or learn how to code them yourself!

Note: when searching for shaders online, don't forget to check out which license the creator has chosen
for his or her work, even if a lot of them are free to use.
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10. The Sequencer

This section deals with how to manage sequences in the timeline, their settings and playback, as well as
their content.

10.1. Module 1: the Sequences

In Proxima, Sequences are the objects that let you divide your mapping in multiple parts,
kind of like scenes, or even slides! They are managed in the Sequences module, in
the Sequencer.

In this article, you'll learn what you can achieve with them, how to organize them and playback
possibilities.

What are sequences?

A Sequence is an object that contains shapes, which are stored in a 👉Map [p.32] and organized in 👉

Groups [p.49] with their effects, and on which you can also apply effects, a transition, as well as include
an audio file.

You can have as many sequences as you want in a project and in each sequence, you can change all
these different elements and thus create a list of preset scenes that you can switch easily.

Edited vs. played

A sequence is represented by a tile in the grid of the module. It can be in three different states:

Edited: the edited sequence is the one with the  Edit button toggled ON . This sequence is the one
shown and editable in the Canvas and whose settings are currently in the Settings 

panel. Only one sequence can be edited at a time and there is always one. 

To make a sequence Editable, simply click on its  Edit button.

Played: the played sequence is the one whose tile is yellow, with a black dot in the top right corner.
This sequence is the one currently displayed in the Output. Only one sequence can be played at a
time and there can also be none.
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To Play a sequence, simply click on its tile (it'll also become Edited). If you click on an empty cell,
there is no Played sequence and the rendering is blacked out.

Edited & Played at the same time: the same sequence can be both the Edited and
the Played sequence. In this case, the sequence is fully yellow in the matrix and is both rendered in
the Output and previewed in the Canvas.

Note: when the Played and Edited sequence are different, a warning appears above the Sequencer to
remind you which sequence you're editing in the Canvas. Since the preview of the rendering is disabled in
the Canvas in this case, it can be confusing.

Draft sequences

If you want to make sure that a particular sequence doesn't get Played, for instance because you are still
working on it or have changed your mind, but still want to keep it close, you can quickly put it
in "Draft" mode (right-click "Mark as Draft").

Draft sequences can still be Edited, but can never be Played, even when mistakenly clicking on them.
When you're ready to publish, right-click and chose "Mark as Ready".

Sequences settings

The content of the Edited sequence can be changed in the Canvas, but a sequence also has a few
properties that you'll find in the associated panel on the right of the module:

Name: the name of a sequence is unique and is displayed on its tile in bold.

Comment: it's a little note that you can add and that will be displayed on the tile in small text below
the name.

Color: the color of the tile representing the sequence in the grid. There are 7 possible colors. It
doesn't affect content.

Maps: shapes are stored in Maps. You can have as many as you want and you can choose which
one to use in each sequence.

Transition in: a sequence can have a unique transition. You can choose one for each sequence from
a wide built-in catalogue (use the "..." button) and set its duration in seconds. The transition is
triggered each time playback of the sequence is started. Most of them even have parameters that
you can customize directly in the settings panel!
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Audio: you have the possibility to add one audio file on each sequence. The track is played when its
associated sequence is Played and stops if the Played sequence changes. The track is restarted
from the beginning each time playback comes back to this sequence.

Shaders: in addition to the content inside the sequence, you can add post-processing effect on top

of it (kind of like filters). They work like 👉shaders on players [p.73].

Managing sequences
Adding sequences

To add a sequence, simply click on the + icon of an empty cell in the grid. 

You can also use the right-click menu or common shortcuts to Copy/Cut/Paste/Duplicate an existing
one, or use Insert to add a new one in a new column before/after.

Note: when you add a new sequence from the + button, it becomes Edited right away, but not Played, that
way you can even add sequences during a live performances without disrupting playback. To add a
sequence that is directly Edited + Played, double-click on the + button.

Organizing sequences

Sequences can be arranged as you wish in the grid, simply drag & drop them to move them around. You
can add or remove rows/columns from the right-click menu in the grid to increase the size of the matrix.

You can even add different tabs of sequences. Each tab represent a new matrix view of sequences. To
add a tab, click on the + icon in the title bar of the module. You can then go through the different view by
clicking to select a tab or by using the arrow buttons.

Note: a sequence is unique and can only exist in one tab view at a time. To move a sequence to another
tab, cut and paste it.
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Automating the playback of sequences with Autopilot
As mentioned previously, to play a sequence, you can simply click on it in the grid manually and it'll be
displayed in the Output, or use the Next and Previous buttons to play through the list of sequences in the

tab. Another manual possibility is the use of 👉Controls [p.99] to trigger the playback.

But in a timed show or even sometimes during a live performance, you might want to play through a few
sequences without manual intervention.

In this case, there are two options: using the Timeline module to program a chain of actions, or use
the Autopilot mode, a quick-to-set-up playback option that is directly integrated in the Sequences
module.

How does Autopilot work

What Autopilot does is that when it's ON, it goes through the list of sequences in a tab and changes
which sequence is playing, one after the other, according to a few settings that you can adjust in the
settings window from the title bar of the module:

To quickly disable the playback of a particular sequence in the list, put it in Draft mode (right-click "Mark
as Draft"). Draft sequences are skipped by Autopilot.

Autopilot settings

Trigger next: this determines which sequencing step Autopilot uses between each sequence change.
The same step is used for all sequence changes. If you want to vary between each sequence please
see the Timeline module.

Duration: Autopilot skips to the next sequence after a fixed duration, either in time or beats.

Source: 

Autopilot skips to the next sequence when the first or last Source playing in the sequence ends.
It is considered that a Source ends when its last media reaches its end (no matter which loop
mode it it set too).
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Note: if no Source is playing in the current sequence, it never skips to the next. Same goes if a
media is on infinite loop in the middle of a Playlist Source, since the end of the last media is
never reached, Autopilot never skips. 

Direction: this determines what the next sequence will be (empty cells don't count).

Left to Right: Autopilot reads sequences in the tab from left to right, row by row.

Random: the next sequence is chosen randomly from the ones in the same tab.

Loop: this decides if Autopilot continues playing from the first sequence once it has finished playing
all sequences in the tab, or if it simply stays on the last one (can only be unchecked in "Left to Right"
direction.)

Scroll follows playback: when this option is checked, the scroll automatically adapts in order to keep
the Played  sequence in the view (only if it's in the current tab) so that you can keep track of
playback. This also works when changing sequence manually while Autopilot is OFF.

Running with Autopilot

To turn ON Autopilot, simply click on the toggle button in the title bar of the module 

 . There are two possibilities:

There is no sequence playing when Autopilot is toggled: the first sequence of the current tab (row 1,
column 1) starts to play and Autopilot will play through the list of sequences in this same tab,
skipping Draft sequences.

There is already a sequence playing when Autopilot is toggled: the activation is seamless, the Played
sequence keeps running and Autopilot simply starts the timer at first. When one step has passed, it
jumps to the next sequence in the same tab (but skips Draft sequences).

To turn OFF Autopilot, simply untoggle the button  . Playback will just stay on the

same sequence until you change it manually.

Note: while Autopilot is ON, you can manually change the Played sequence. In this case, a new step
begins and playback resumes from this sequence. If the trigger in question is on an empty cell, then it
stays on loop in blackout until you manually change it again. 

 

10.2. Module 2: the Timeline
The Timeline is a Sequencer module that allows you to program a chain of actions at specific times. The
playback of sequences can thus be automated.

The waveform of an audio file can be used to set up action cues on a sound.

Overview
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Tracks

The Timeline is divided into multiple components. At the center, 3 tracks are stacked up and follow
the same time line:

at the top, the time track, where the playhead runs and that indicates the time.

in the middle, the cue track, where cue labels appear. Cues are this little flags that allow you to
program automatic actions that are triggered when the playhead reaches them. Their behavior is
detailed later in this article.

at the bottom, the audio track, where the audio waveform is displayed when an audio file is
added on the Timeline.

This center part of the Timeline can be scrolled horizontally (using the scrollbar, a mousewheel click
& drag, or by holding [Shift] while scrolling vertically) and is zoomable using a simple vertical scroll or
the dedicated buttons (see next paragraph).

Playback controls

On the left, the playback controls allow you to start and make the playhead progress.

 Play/Pause

, the button has 3 states:

 

 indicates that the timeline is neither playing, nor paused: the playhead doesn't progress
and if it moved manually, cues that it passes are not activated. If the button is clicked, the
Timeline starts playing.

 indicates that the timeline is playing: the playhead progresses along the time track and
triggers cues it passes. If the button is clicked, the timeline pauses.

 indicates that the timeline is paused: the playhead doesn't move and the timeline holds.
The master opacity of the output is set to the value set in the timeline settings (see below).
If the button is clicked, the timeline resumes playback.

 Stop: stops the timeline completely, places the playhead at 00:00:00.000, resets the
Play/Pause button and switches the rendering to Blackout (no sequence playing).

    Previous/next cue: places the playhead on the closest next cue before/after its
current position. If the timeline was stopped, then the playhead is simply moved and stays put.
Otherwise, playback continues and if the target cue is a "Play" action, it is triggered.
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Playhead position: indicates the position of the playhead on the time track. The playhead can be
moved manually by giving it a new position in the input field, by sliding it on the time track, by
clicking on a position on one of the tracks, or using the keyboard arrow keys (by 1ms).

Toolbar
On the right, the toolbar allows you to access tools and parameters of the timeline:

 Adjust height: allows you to expand/reduce the height of the Timeline. I can either have a
minimal height or take up half of the total height of the Sequencer (or all of it if the Sequences
module is hidden.)

 Settings:

Timeline length: 

determines the length of one timeline loop. When the playhead reaches the end, it starts
back from the beginning.

Note: if the timeline length is reduced, all cues that were in a part that got cut are placed at
the end.

Override master opacity when paused: this setting determines the value that temporarily
overrides the current value of the master opacity of the output when the timeline is paused.

Audio file and associated buttons: indicates the name of the imported audio file if there's
one on the timeline and gives you the possibility to delete or replace it.

Scroll follows playhead: when this option is checked, the scroll automatically adapts in
order to keep the playhead in the view.

 Add cue: allows you to add a cue at the position of the playhead by choosing an action from
the dropdown menu. Actions are detailed in a later paragraph.

 Add audio: allows you to choose and audio file from your computer. The file will be added

on the timeline with its waveform, from 00:00:00.000.

  Zoom: allows you to zoom/unzoom on the timeline tracks. The minimum zoom level is
reached when the whole length of the timeline fits in the view. It's also possible to zoom with the
mouse wheel.

Using cues to program actions
What's a cue?

A cue is an object of the timeline used to send a signal that triggers an action related to sequence
playback. It takes the form of a little flag positioned at a precise time on the timeline, activated when the
playhead reaches its position during playback.

Adding a cue

There a multiple ways to add a cue, you can:

Drag & drop a sequence directly on the cue track to create an associated "Play" cue at a precise
timestamp.
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Use the associated button   in the toolbar of the timeline and choose an action. The new cue will
be placed at the current position of the playhead.

Right-click on the cue track and choose an action to add a cue at a precise timestamp.

Double-click on the cue track to add a "None" cue, that only serves as a marker at a precise
timestamp.

Copy/Cut/Paste an existing one by selecting it and using the right-click menu or common shortcuts.
Copies will be placed at the current position of the playhead.

Selecting a cue

When a cue is added, it automatically becomes selected. Otherwise, you just have to click on a cue label
to select it and click on an empty space of the cue or audio track to deselect it.

Note: only one cue can be selected at a time.

Editing a cue

When a cue is selected, its settings appear in the related panel on the right. Here's a list of a cue's
parameters and its actions in particular:

Name: the name of the cue, written on its tag.

Color: the color of the cue in the timeline (7 possible)

Timestamp: the position of the cue on the timeline. In the case where multiple cues hold the same
exact position, only one will be activated.

Action: 

Play: unfolds a dropdown that lists all existing sequences and a "Blackout" option. The "Play" 

action triggers the broadcast of the targeted sequence, as if it were clicked in the sequences
module and became the played sequence. This action doesn't alter the progression of the
playhead.

Note: if the chosen option is "Blackout", the action is equivalent to clicking on an empty cell of
the sequences module (no sequence playing).
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Pause: 

stops the playhead at the cue position and puts the timeline on hold. The output of the currently
playing sequence (or blackout) is not interrupted, but it's possible to give a temporary master
opacity value to the output in the timeline settings.

Stop: stops the playhead and places it at 00:00:00.000. The timeline is stopped and the
rendering is blacked out (no sequence playing).

Jump to: unfolds a dropdown that lists all existing cues and a "Start" option. The "Jump to" 

action makes the playhead jump to the position of the targeted cue, as if it were double-clicked.
This action moves the playhead, which continues its run from this point (the "Start" option
defines the 00:00:00.000 position).

Note: if the targeted cue has a "Play" action, then it is triggered.

None: doesn't trigger any action and doesn't alter the progress of the playhead, it can only be
used as a reference.

Note: if an object targeted by an action is deleted, then the associated cue(s) directly becomes inactive
and serves as a marker until the object is recovered or the action changed manually.

Deleting a cue
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To delete a cue, simply click on its label and use [Delete/Backspace] or Right-click -> Delete.

10.3. Audio & tempo reactivity

You'll find the Tempo and Audio Analysis module in the Sequencer, at the bottom of the
interface.

The tempo
To make your mapping more lively, you can animate your effects on the beat. This can be used as a trick
if you don’t have a good microphone to coordinate your effects with sound: just adapt the tempo in
Proxima to the rhythm of the ambient music, you’ll get the illusion that sound and animations are linked!

Note: the tempo specified in this module also regulates the duration of Autopilot steps if it is set to
tempo mode (as opposed to time mode).

Setting a BPM value

You can set a value for the tempo in the input box, or tap along to a tempo by clicking on the TAP button
and the value will be adjusted to your rhythm. This value is expressed in Beats per Minute (BPM) and
must be between 20 and 999.

You can check if the tempo corresponds to what you want with the visual indicator at the bottom of the
module: the little yellow line moves to the beat you set. Using the TAP button, you need to click regularly
a few times so that the BPM value can be calculated precisely. If you feel like it’s a bit off, you can
increase or decrease the value slightly with the up and down arrows of the input field.

The Resync button is also there to help you in this process of setting a coordinated tempo: click on it on
the first beat of a bar in your sound in order to restart the visual indicator to the beginning (i.e. the yellow
line starts back from the bar).

 

Linking the BPM value to that of another app

Head over to 👉this article [p.132] to learn how to link the tempo value of Proxima to other apps
with Ableton Link.

The audio analysis module
The sound analysis module allows you to make Proxima effects react to an audio source so that your
mapping adapts to the atmosphere. You can activate this module by clicking on the toggle button in its
title bar.
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Selecting an audio source
When you activate the sound analysis module, one audio source will be selected by default (if there's
at least one available). Click on the gear icon  to access the settings window and see which other

audio sources, like microphones, are available. You can select the one that should be used by
Proxima in the drop-down list located in the header of the window.

These sources can be:

Microphones: when you want to capture the ambient live sound in your performance.

Audio files that you've imported into the project: choose "Proxima Timeline & Sequences
Audio" as input so that the audio file(s) you have added on the Timeline or in Sequence settings
get analysed when they play.

Sound from your computer: sometimes, your microphone may not be of good quality and you get
some unwanted noise. Or you simply don’t have a microphone, so you might want to use sound
coming directly from your computer.

Adjusting the gains
You can set the overall input gain, in order to adjust the level of the signal sent by your microphone or
another input device. You can adjust it with the slider on the left of the module, or in the settings
window (accessible with the gear icon ). In addition, the settings window has one gain slider for

each frequency range, for more precision. Do the adjustments with your audio source activated, until
the amplitude of the values in the spectrums satisfies you.

Note: usually, the audio interfaces you use as input also have a gain or input volume level control.

Adjusting the frequency ranges
When the analysis is activated, you can see the little bars in the module react when a sound is
captured. These bars represent the average values calculated for each frequency range in the
settings window: Bass, Mid, High.
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The limits taken into account for each frequency range can be adjusted on the spectrum, going from
low to high frequencies (from left to right). If an average bar is high, it means that the frequencies
contained in the associated range you have set have a high level in your sound.

Later, you’ll be able to make your effects react to these different ranges. By default, Bass is the range
that contains the five lowest frequencies, Mid contains some in the middle and High contains the
highest frequencies. 

Note: A frequency range cannot be discontinuous. However, the three ranges combined don’t have to
cover the full spectrum and can overlap.

Making effects react to the beat or sound
Once your tempo and audio ranges are set, you can start to connect effect parameters, to make them
vary according to the beat or a sound.

All compatible parameters will have a little dropdown menu with different variations on the left. You'll find
these kind of parameters in group effects, sequence effects, player effects, transitions.

Head over to 👉this article [p.49] to see what the variations look like and how to find them.
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11. Master Shaders

11.1. Adding master effects on the rendering
As you might have seen throughout this guide by now, there are many, many content and effect
possibilities in Proxima. You can combine group effects in facecs with multimedia content, etc

On top of that, you can add effects that are like "filters" and affect the rendering: post-processing
shaders. The two types that affect the whole rendering are sequence shaders and, our focus here, the top
of the tops, master shaders.

Using Master Shaders
What are those?

Master Shaders are effects that apply to the whole rendering. Unlike sequence shaders, they are not
linked to any sequence so they apply to whatever's playing in the output at any time.

The effects that can be added as Master Shaders are ISF post-processing shaders. Proxima contains a
built-in library of these.

Adding Master Shaders

To add a Master Shader:

1. Open the Master Shaders panel from the toolbar on the right  .

2. Click on the + icon in the header.

3. Select an effect in the shaders library and double-click on it or use the "Open" button.

Note: you can add as many shaders as you want and even add the same effect multiple times.

Arranging Master Shaders

The order of shaders in the list has an importance: transformations are applied shader by shader, in order,
from the bottom of the list to the top. That means that the one at the top of the list is applied last, after
all others and this can have a great impact.

By default, each new shader added is put on top, but you can edit the order afterwards by simply drag &
dropping an item in the list to change its position.

Some shader combinations have a really different output depending on the order they're in. Try messing
it up!
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Managing individual shader settings

A shader can be disabled without deleting it from the list with the switch next to the effect name. It can
be useful to toggle them momentarily when you want to try different combinations.

In addition, shaders can have parameters, so you can customize their effect! Most of the shaders
included in Proxima have at least one.

You can see and customize them by clicking on the cog icon next to the effect name. Most of the

parameters can even be animated with 👉variators [p.49], as you would do for group effect parameters.

Note: use the lightning icon  at the top right of the parameters panel to quickly load a Preset of values for
this shader or save a new one with a combination of parameters you like.

Managing global shader settings

Above the list of shaders, you'll find buttons associated with bulk actions (global settings, toggle all and
delete all). In the settings, there's one option: "Clip master shaders overflow".

When checked, this option ensure that the rendering stays confined to the limit of the shapes you've
drawn, even if the transformations applied by master shaders create an overflow. 

Note: by default this option is unchecked and the choice is saved in the project file.

Proxima Master Shaders

Jan, 11th 2024 97



Adding effects to the library
In addition to the built-in effects, you can add your own shaders. To do so, simply open the library again
and head over to the tab called "My Shaders".

There, you can browse your files and import .fs shaders. On players, shaders added to the library can only
be Post-Processing ISF shaders with a maximum of 1 input image.

To find these, you can look on websites like this one, by the creators of the ISF

standard: editor.isf.video[https://editor.isf.video/]... Or learn how to code them yourself!

Note: when searching for shaders online, don't forget to check out which license the creator has chosen
for his or her work, even if a lot of them are free to use.
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12. Controlling Proxima Remotely

This section contains information about the ways to control Proxima by other means than just your
mouse. You’ll learn how to tell Proxima what to do with your keyboard or via OSC for instance.

12.1. Controlling Proxima with a Keyboard
Did you know that it's possible to control Proxima by other means than your mouse or trackpad? Because
let's face it, while those are extremely useful to draw and adjust parameters while you're sitting at your
desk, having to scroll for a tiny effect switch while performing live is not the most fun. That's why you can
make your life easier with external controls, and use a keyboard for example.

 

Default Keyboard shortcuts

To make your workflow smoother and reduce the number of clicks you have to perform to access some
features, we have already implemented some keyboard shortcuts in the software. The updated list of key
combinations for the version you are using is accessible directly in the software from Controls →
Keyboard Shortcuts List... or with the shortcut [CTRL/Cmd + /].

Custom shortcuts

In addition to these default shortcuts, you can also set your own keyboard commands for Proxima. To do
so, you have to make the elements in the app interface "learn" which key they should react to.

Enabling Keyboard Learning

To assign keys, you first need to enable the keyboard Learning interface. Activate it from Controls → Edit
Keyboard Assignments, or head over to the Keyboard tab of the Controls Settings window (from Controls
→ Settings... or   in the toolbar) and click on the "Keyboard Learning mode" button.

You'll then see a colored overlay on many interface elements in Proxima.

Adding assignments

You can set a custom key for every button or slider that has an overlay: simply click on it (it will be circled
in yellow) and hit the desired key on your keyboard. This will associate the key and interface element
together and you'll see it appear in the list in the Controls window.

Note: you can assign the same key to multiple commands at the same time. For example, one single key
can be linked to multiple effect toggles, so that when you hit it later, all these effects turn on at once!
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Unlike the default shortcuts, your custom assignments cannot be key combinations, they have to be
single keys. Special keys and symbols have been blocked (for instance CTRL/Cmd, Tab, Enter, etc), if you
try to assign one of these it will not be taken into account.

Once you're done, you can simply toggle the edition mode off from the same button/menu or with [Esc].
Now if you press one of the custom keys, it will trigger the associated command(s) in the software!

Note: if you press [CTRL/Cmd], [Alt] or [Shift] at the same time as an assignment, the custom shortcut
will not be triggered, to prevent conflict with most default shortcuts. For instance, if you use [CTRL/Cmd
+ Z] and [Z] is also assigned to Seq 1 / Play, the combination will only trigger the
default "Undo" command associated with [CTRL/Cmd + Z]. 

Editing assignments

If you want to change an assignment afterwards, just toggle the Learning mode on again, click on the
targeted control again and hit a new key.

Deleting assignments

There are 3 possibilities to delete assignments:

When the Learning mode is ON, select an overlay and hit [Delete/Backspace]. This will remove the
selected assignment.

Right-click on a single assignment in the table in the Controls window and click on the "Delete
assignment" 

option. This will remove the selected assignment.

Use the "Delete all assignments" button above the table in the Controls window. This will remove all
keyboard assignments in the project.

Saving assignments

The Keyboard assignments you set are directly saved in your .pxm project file.

Assignment settings

Each assignement you configure has a set of settings, as you can see in the assignments table of the
Controls window.

For Keyboard assignments, you can edit:

The Toggle behavior: if checked, your keyboard key will work as a "toggle" button, if not, it will work
as a "push" button on this assignment. Here is an example for the two states, for instance with a key
assigned to a slider in Proxima:

Toggle is checked: if you press & release the key, it will set the slider to the max value. If you
press & release it again, it will set it to the min value. And so on.

Toggle is unchecked: if you press the key, it will set the slider to the max value. When you
release it, it will set it to the min value.

The Range: this setting appears on sliders or spinboxes for instance. By setting a Min and a Max,
you can override the range of the interface element in Proxima. For example if you set the range to 1
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- 15 for the Thickness of the Border effect, when you move the fader you have assigned to it the
values will only vary between 1 and 15 no matter how hard you move your fader!

12.2. Controlling Proxima with a mobile or tablet via OSC
This tutorial is intended to help you understand how to use the OSC protocol, in order to control Proxima
from a remote wireless device or app.

In this guide, we’ll mostly focus on how to control Proxima from an iOS or Android app, with tools that
allow for a quick and easy setup. But know that there are many more connections possible via OSC: for

example it also allows you to use the timeline-based sequencer app Vezér[https://imimot.com/vezer/], or the

modular machine Chataigne[https://benjamin.kuperberg.fr/chataigne/en].

What is OSC?
OSC is the acronym for “Open Sound Control”. It’s a protocol that is used for communication between
multimedia devices, it allows the transfer of bigger data, faster, and through networks like Wifi and
Ethernet. In short, this protocol will allow you to control some features in Proxima remotely. The great
news is that there’s no need to connect everything with kilometers of cable, your devices just need to be
on the same network.

This opens up endless possibilities for interactive installations!

Finding a layout
Since you won’t be using Proxima directly on your smartphone, you need to use an app with a special
layout, in order to have a functional user interface, with sliders and buttons. There are many apps that let
you build these control panels or have layout templates. Here's an example of a layout

in TouchOSC[https://hexler.net/touchosc#_]: 

You have two options to get a layout:

Option 1: build a layout from scratch

We won’t get into details about how to create a layout here, but you can find many resources on the
internet on the subject. If you have the skills and are courageous, you can code it, or you can use a

WYSIWYG editor, like TouchOSC[https://hexler.net/software/touchosc], or the Lemur

Editor[https://liine.net/en/products/lemur/]. In these cases, the editors are free to install on a computer, but the
layouts you create will only work with the associated applications you buy from the app store. (You can
usually also build a layout directly from the mobile or tablet app!)
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Building a layout requires creating the elements of the user interface, importing the layout in the app if
you built it on a computer and assigning Proxima commands to them. To learn how to import your layout,
please refer to the associated app's manual.

Creating a layout your own layout can be fastidious, but you'll get more control over how each element
works, what information it sends to Proxima and when, etc.

Option 2: configure an existing template

Some apps provide you with layout templates. That means that the first step is done: buttons, sliders, or
other interface elements are already organized in tabs, but you still have to configure them. Indeed, these
elements are “empty”, they don’t have any assignment so they are not linked to Proxima features yet.

Using a pre-existing layout only requires assigning Proxima commands to the elements. 

⚠ If you're building your own template and messages, know that Proxima reacts to float arguments
between 0.0 and 1.0 in OSC messages. For sliders, 0.0 represents the minimum value and 1.0 the
maximum. For toggles, 0.0 means OFF and 1.0 means ON.

Connecting TouchOSC and Proxima
The next paragraphs will give specific instructions to help you get set up with

the TouchOSC[https://hexler.net/touchosc#_] app and Proxima.

To follow these instructions, you need to open Proxima, TouchOSC and to have a layout ready. If you are
using another app, this still might help you as you'll probably find many similarities. Otherwise, please
refer to the app's manual.

Note: your devices need to be connected to the same network to communicate, but it doesn’t necessarily
have to be a wireless connection: your smartphone can use the Wifi and your computer can use Ethernet
for example.

In TouchOSC

Note: these instructions describe the procedure to follow with the iOS version of the app. The Android
interface is slightly different but the actions are similar, unless specified.

1. First, open the Connections settings by pressing the button with the chain link icon in the editor
toolbar, and go to the "OSC" tab.

2. There, in the "Host" input field of the first Connection, you need to enter your computer’s IP address.
You can usually find it under Settings or System Preferences, in the Network properties.

3. In the "Send Port" and "Receive Port" input fields, enter any number between 7 000 and 10 000. (But
use different ones in both fields.)

4. Keep this tab open, as you'll need information from there, and head over to Proxima.

In Proxima
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1. Open the Controls Settings window from Controls → Controls Settings... or   and go to the

"OSC" tab. Make sure that OSC Control is ON with the toggle at the top.

2. Then, in "Incoming port", you need to put the number that you put in the "Send Port" field in
TouchOSC. Inversely, in "Outgoing port", type in the number that is indicated in the "Receive
Port" field in TouchOSC.

3. In "Output IP address", type in your phone or tablet's IP address. You can usually find it in
the Network settings, or some OSC apps sometime display it directly.

Now, go back to your layout and follow the next section of this tutorial to learn how to connect its
elements to Proxima commands.

Note: if you are having trouble after having followed these instructions, you can consult the TouchOSC

documentation[https://hexler.net/docs/touchosc] on their website, it is quite thorough and describes
procedures with iOS devices, as well as other advanced features in the app.

Managing Assignments
Enabling OSC Learning

Once your connection is set, you can start assigning buttons, faders, pads and anything your layout
contains to commands in Proxima. To do so, you have to make the elements in the software interface
"learn" which item in your OSC layout they should react to.

For that, you need to toggle the OSC Learning interface from the Controls window ("OSC learning
mode" button) or menu (Controls → Edit OSC Assignments). A colored overlay will appear over the
elements you can map in the interface.

Adding assignments

Select an overlay element with your mouse or trackpad (it will be circled in yellow) and just move or hit
the control item on your OSC layout that you want to use with it. This will associate the OSC and
interface controls together and you'll see it appear in the list in the Controls settings window.

Once you're done, you can simply toggle the learning mode off with the same button/menu or with [Esc].
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Note: you can assign the same OSC layout element to multiple commands at the same time. For
example, one single button on your device can be linked to multiple effect toggles, so that when you hit it,
all these effects turn on at once!

⚠ If you're building your own template and messages, know that Proxima reacts to float arguments
between 0.0 and 1.0 in OSC messages. For sliders, 0.0 represents the minimum value and 1.0 the
maximum. For toggles, 0.0 means OFF and 1.0 means ON.

Editing assignments

To edit the assignments, just turn on the learning mode again. Then, simply select the desired
assignment and trigger the new OSC control you want to use.

Deleting assignments

There are 3 possibilities to delete assignments:

When the Learning mode is ON, select an overlay and hit [Delete/Backspace]. This will remove the
selected assignment.

Right-click on a single assignment in the table in the Controls window and click on the "Delete
assignment" 

option. This will remove the selected assignment.

Use the "Delete all assignments" button above the table in the Controls window. This will remove all
OSC assignments in the project.

Saving assignments

The OSC assignments you set are directly saved in your .pxm project file.

Assignment settings

Each assignement you configure has a set of settings, as you can see in the assignments table of the
Controls window.

For OSC assignments, you can edit:

The Range: this setting appears on sliders or spinboxes for instance. By setting a Min and a Max,
you can override the range of the interface element in Proxima. For example if you set the range to 1
- 15 for the Thickness of the Border effect, when you move the fader you have assigned to it the
values will only vary between 1 and 15 no matter how hard you move your fader!
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12.3. OSC API
In addition to the possibility to assign your own OSC adresses with the Learning Mode, you can use the default OSC address that are already in place.

Each assignable element of the interface has been given at least one address. If it has more than one address, it means the same result can be achieved in
multiple ways. For instance, if you want to edit a sequence, you can reach it via its name or by its position, which means there are 2 addresses for an
action.

Ready-to-use templates using the OSC API
The API can be used to build custom templates that can be used with any project, without having to go through the Learning process. To make your life

easier, we've build a few ones using the popular OSC app TouchOSC[https://hexler.net/touchosc]. You can use them as is or quickly copy-paste objects to build
your own quickly.

File Description Proxima v. Format Project

Sequencer_v1[https://help.heavym.net/hc/article_attachments/14404271333778] a template
focusing on live
Sequences
control, with 4
tabs of 8x8
sequences and
a few Master
Shaders
shortcuts

1.0 2160×1620

(iPad 9)

-
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GroupEffects_v1[https://help.heavym.net/hc/article_attachments/14404316823058] a simple
template
containing
Group
effects
parameters
(no LFO
control)

1.0 2160×1620

(iPad 9)

-

Mix_v1[https://help.heavym.net/hc/article_attachments/14404303657874] a template
with an
A/B
crossfader,
intended to
control the
simple mix
of 2
blended
Groups.

As it is a
bit out of
the usual
Proxima
use, an
example
project is
provided!
(see 4th
column)

1.0 2160x1620

(iPad 9)

-
[https://help.heavym.net/hc/article_attachments/14404330635666]
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Screenshot of Sequencer v1

up next: Timeline control, group effects with LFO controls

 

API reading instructions
The full list of messages in the API can be found in the tables below. Each table uses the same structure:

1st column: description of the action

2nd column: default OSC address(es)

3rd column: argument (always float unless stated)

You'll see it gets veeeery long real quickly so we've used abbreviations throughout the article. In a table, if
you see a word between [brackets], please refer to the following instructions to understand what's
expected in the address:

[n] corresponds to a integer number, for instance the number of the row where a sequence is, or the
position of a group in the Layers list, etc. For shader and group lists, the count starts from the bottom, at
1.

[seqName] corresponds to the name given to the sequence, without spaces. For instance, if you've
named it "Act 1-2", then [seqName] = act1-2

[cueName] corresponds to the name given to the cue, without spaces. For instance, if you've named it
"Play Act 1-2", then [cueName] = playact1-2

[groupName] corresponds to the name given to the group, without spaces. For instance, if you've named
it "Group 4", then [groupName] = group4

[shaderName] corresponds to the name of the shader displayed in the interface, without spaces and file
extension. For instance, if your shader is named "Chroma Zoom", then [shaderName] = chromazoom

[parameterName] corresponds to the name of the parameter displayed in the interface, without spaces. It
always relates to shaders. For instance, if your parameter says "master_zoom", then [parameterName] =
master_zoom

[variable] depends on the type of parameter you're targeting. For group effects, [variable] always refers to
a parameter using a slider. For shaders, there are a few additionnal possibilities. Here is
what [variable] can mean (with arguments between parenthesis): 

If the parameter uses a slider

, you can target its value but also the properties linked to its LFO variations:

- value (0.0 (0) to 1.0 (100))
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- lfo/mode (0.0 Fixed ; 0.1 Sine ; 0.2 Triangle ; 0.3 Trapezoid ; 0.4 Square ; 0.5 Saw Up ; 0.6 Saw Down ; 0.7 Noise ; 0.8 Bass ; 0.9 Mid ; 1.0 High)

- lfo/min (0.0 (0) to 1.0 (100))

- lfo/max (0.0 (0) to 1.0 (100))

- lfo/tempo (0.0 (0) to 1.0 (100))

- lfo/speed (0.0 (0) to 1.0 (100))

If the parameter uses a checkbox: value (0.0 (unchecked) ou 1.0 (checked))

If the parameter uses a list: value (0.0 (top item) to 1.0 (bottom item))

If the parameter is an event, using a button: trigger (1 to trigger)

If the parameter is a point

, using an x and y graph:

- x (0.0 (min) to 1.0 (max))

- y (0.0 (min) to 1.0 (max))

Don't worry, examples will be given throughout the article!

List of default OSC messages
Master

Master opacity

Opacity /master/opacity/value 0.0 (0%)
to 1.0
(100%)

 

Master shaders
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Toggle all /master/shaders/all/toggle 1 (on) or 0 (off)

Toggle one /master/shaders/[shaderName]/toggle

/master/shaders/[n]/toggle

1 (on) or 0 (off)

Parameters /master/shaders/[shaderName]/[parameterName]/[variable]

/master/shaders/[n]/[parameterName]/[variable]

depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]

// examples for Chroma Zoom.fs, in second position from the bottom of the list

/master/shaders/chromazoom/toggle

/master/shaders/2/toggle

/master/shaders/chromazoom/master_zoom/value

/master/shaders/chromazoom/master_zoom/lfo/mode

/master/shaders/chromazoom/master_zoom/lfo/min

/master/shaders/chromazoom/master_zoom/lfo/max

/master/shaders/chromazoom/master_zoom/lfo/tempo

/master/shaders/chromazoom/master_zoom/lfo/speed

/master/shaders/2/master_zoom/value

...

 

Sequencer

Sequence controls
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Edit /sequences/[seqName]/edit

/sequences/tabs/[n]/rows/[n]/columns/[n]/edit

1

Play /sequences/[seqName]/play

/sequences/edited/play

/sequences/tabs/[n]/rows/[n]/columns/[n]/play

1 (play) or
0 (stop)

Play
previous

/sequences/playprevious 1

Play next /sequences/playnext 1

Play
blackout

/sequences/blackout 1

// examples for a sequence named "Seq 1-2"

// located in the second tab, row 2 & column 2

/sequences/seq1-2/edit

/sequences/tabs/2/rows/2/columns/2/edit

/sequences/seq1-2/play

/sequences/tabs/2/rows/2/columns/2/play

 

Sequence transitions

Parameters /sequences/[seqName]/transition/[parameterName]/[variable]

/sequences/edited/transition/[parameterName]/[variable]

/sequences/tabs/[n]/rows/[n]/columns/[n]/transition/[parameterName]/[variable]

depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]

// examples for a sequence named "Seq 1-2"

// located in the second tab, row 2 & column 2
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// with an Angular transition

/sequences/seq1-2/transition/startingangle/value

/sequences/edited/transition/startingangle/value

/sequences/tabs/2/rows/2/columns/2/transition/startingangle/value

/sequences/seq1-2/transition/startingangle/value

/sequences/seq1-2/transition/startingangle/lfo/mode

/sequences/seq1-2/transition/startingangle/lfo/min

/sequences/seq1-2/transition/startingangle/lfo/max

/sequences/seq1-2/transition/startingangle/lfo/tempo

/sequences/seq1-2/transition/startingangle/lfo/speed

/sequences/edited/transition/startingangle/value

...

 

Sequence shaders

Toggle /sequences/[seqName]/shaders/[shaderName]/toggle

/sequences/edited/shaders/[shaderName]/toggle

/sequences/tabs/[n]/rows/[n]/columns/[n]/shaders/[shaderName]/toggle

/sequences/[seqName]/shaders/[n]/toggle

/sequences/edited/shaders/[n]/toggle

/sequences/tabs/[n]/rows/[n]/columns/[n]/shaders/[n]/toggle

1 (on) or 0 (off)
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Parameters /sequences/[seqName]/shaders/[shaderName]/[parameterName]/[variable]

/sequences/edited/shaders/[shaderName]/[parameterName]/[variable]

/sequences/tabs/[n]/rows/[n]/columns/[n]/shaders/[shaderName]/[parameterName]/[variable]

/sequences/[seqName]/shaders/[n]/[parameterName]/[variable]

/sequences/edited/shaders/[n]/[parameterName]/[variable]

/sequences/tabs/[n]/rows/[n]/columns/[n]/shaders/[n]/[parameterName]/[variable]

depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]

// examples for a sequence named "Seq 1-2"

// located in the second tab, row 2 & column 2

// with Chroma Zoom.fs, in second position from the bottom of its list

/sequences/seq1-2/shaders/chromazoom/toggle

/sequences/edited/shaders/chromazoom/toggle

/sequences/tabs/2/rows/2/columns/2/shaders/chromazoom/toggle

/sequences/seq1-2/shaders/2/toggle

/sequences/edited/shaders/2/toggle

/sequences/tabs/2/rows/2/columns/2/shaders/2/toggle

/sequences/seq1-2/shaders/chromazoom/master_zoom/value

/sequences/seq1-2/shaders/chromazoom/master_zoom/lfo/mode

/sequences/seq1-2/shaders/chromazoom/master_zoom/lfo/min

/sequences/seq1-2/shaders/chromazoom/master_zoom/lfo/max

/sequences/seq1-2/shaders/chromazoom/master_zoom/lfo/tempo

/sequences/seq1-2/shaders/chromazoom/master_zoom/lfo/speed

/sequences/edited/shaders/chromazoom/master_zoom/value

...

 

Tabs
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Select /sequences/tabs/[tabName]/select

/sequences/tabs/[n]/select

1

Select
previous

/sequences/tabs/selectprevious 1

Select
next

/sequences/tabs/selectnext 1

// examples for a tab named "Draft 1", in second position from the left

/sequences/tabs/draft1/select

/sequences/tabs/2/select

 

Autopilot

Toggle /autopilot/toggle 1 (on) or 0
(off)

Select
direction

/autopilot/direction 0 (left to
right) or 1
(random)

 

Timeline

Play /
Pause

/timeline/play 1 (play) or
0 (pause)

Stop /timeline/stop 1

Playhead
position

/timeline/playhead/position 0.0 (start)
to 1.0
(end)

Go to cue /timeline/cues/[cueName]/goto

/timeline/cues/[n]/goto

 1

Go to next
cue

/timeline/next 1

Go to
previous
cue

/timeline/previous 1

Cue
timestamp

/timeline/cues/[cueName]/timestamp

/timeline/cues/[n]/timestamp

0.0 (start)
to 1.0
(end)

// examples for a cue named "Play Seq 1-2", in second place from the left

/timeline/cues/playseq1-2/goto

/timeline/cues/2/goto

/timeline/cues/playseq1-2/timestamp
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/timeline/cues/2/timestamp

 

Audio Analysis

Toggle /audioanalysis/toggle 1 (on) or 0
(off)

Global
gain

/audioanalysis/gain/global 0.0 (min)
to 1.0
(max)

"Bass"
gain

/audioanalysis/gain/bass 0.0 (min)
to 1.0
(max)

"Mid" gain /audioanalysis/gain/mid 0.0 (min)
to 1.0
(max)

"High"
gain

/audioanalysis/gain/high 0.0 (min)
to 1.0
(max)

 

Tempo

BPM
Value

/tempo/bpm 0.0 (20) to
1.0 (999)

TAP /tempo/tap 1

Resync /tempo/resync 1

Toggle
Ableton
Link

/abletonlink/toggle 1 (on) or 0
(off)

 

Groups

Group selection

Select /sequences/[seqName]/groups/[groupName]/select

/sequences/edited/groups/[n]/select

1

Select
above

/sequences/edited/groups/selectabove 1

Select
below

/sequences/edited/groups/selectbelow 1

// examples for a groupe named "Group D"

// in fourth position from the bottom of the list

// in a sequence named "Seq 1-2"
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/sequences/seq1-2/groups/groupd/select

/sequences/edited/groups/4/select

 

Group properties

Opacity /sequences/[seqName]/groups/[groupName]/opacity/[variable]

/sequences/edited/groups/[n]/opacity/[variable]

/sequences/edited/groups/selected/opacity/[variable]

depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]

// examples for a groupe named "Group D"

// in fourth position from the bottom of the list

// in a sequence named "Seq 1-2"

/sequences/seq1-2/groups/groupd/opacity/value

/sequences/edited/groups/4/opacity/value

/sequences/edited/groups/selected/opacity/value

/sequences/seq1-2/groups/groupd/opacity/lfo/mode

/sequences/seq1-2/groups/groupd/opacity/lfo/min

/sequences/seq1-2/groups/groupd/opacity/lfo/max

/sequences/seq1-2/groups/groupd/opacity/lfo/tempo

/sequences/seq1-2/groups/groupd/opacity/lfo/speed

/sequences/edited/groups/4/opacity/lfo/mode

...

 

Group shaders
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Toggle /sequences/[seqName]/groups/[groupName]/shaders/[shaderName]/toggle

/sequences/edited/groups/[n]/shaders/[shaderName]/toggle

/sequences/edited/groups/selected/shaders/[shaderName]/toggle

/sequences/[seqName]/groups/[groupName]/shaders/[n]/toggle

/sequences/edited/groups/[n]/shaders/[n]/toggle

/sequences/edited/groups/selected/shaders/[n]/toggle

1 (on) or 0 (off)

Parameters /sequences/[seqName]/groups/[groupName]/shaders/[shaderName]/[parameterName]/[variable]

/sequences/edited/groups/[n]/shaders/[shaderName]/[parameterName]/[variable]

/sequences/edited/groups/selected/shaders/[shaderName]/[parameterName]/[variable]

/sequences/[seqName]/groups/[groupName]/shaders/[n]/[parameterName]/[variable]

/sequences/edited/groups/[n]/shaders/[n]/[parameterName]/[variable]

/sequences/edited/groups/selected/shaders/[n]/[parameterName]/[variable]

(depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07])

// examples for a groupe named "Group D"

// in fourth position from the bottom of the list

// in a sequence named "Seq 1-2"

// with Chroma Zoom.fs, in second position from the bottom of its list

/sequences/seq1-2/groups/groupd/shaders/chromazoom/toggle

/sequences/edited/groups/4/shaders/chromazoom/toggle

/sequences/edited/groups/selected/shaders/chromazoom/toggle

/sequences/seq1-2/groups/groupd/shaders/2/toggle

/sequences/edited/groups/4/shaders/2/toggle

/sequences/edited/groups/selected/shaders/2/toggle

/sequences/seq1-2/groups/groupd/shaders/chromazoom/master_zoom/value

/sequences/seq1-2/groups/groupd/shaders/chromazoom/master_zoom/lfo/mode

/sequences/seq1-2/groups/groupd/shaders/chromazoom/master_zoom/lfo/min
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/sequences/seq1-2/groups/groupd/shaders/chromazoom/master_zoom/lfo/max

/sequences/seq1-2/groups/groupd/shaders/chromazoom/master_zoom/lfo/tempo

/sequences/seq1-2/groups/groupd/shaders/chromazoom/master_zoom/lfo/speed

/sequences/edited/groups/4/shaders/chromazoom/master_zoom/value

...

 

Group effects

Toggle effect // Addresses follow this structure

:

// /sequences/edited/groups/selected/[effectType]/[effectTab]/toggle

/sequences/edited/groups/selected/outline/border/toggle

/sequences/edited/groups/selected/outline/line/toggle

/sequences/edited/groups/selected/filling/color/toggle

/sequences/edited/groups/selected/filling/special/toggle

/sequences/edited/groups/selected/filling/snake/toggle

/sequences/edited/groups/selected/transformation/rotation/toggle

/sequences/edited/groups/selected/transformation/structure/toggle

1 (on) or 0 (off)
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Select mode // Addresses follow this structure:

// /sequences/edited/groups/selected/[effectType]/[effectTab]/[effectMode]/select

// Border

/sequences/edited/groups/selected/outline/border/basic/select

/sequences/edited/groups/selected/outline/border/blinking/select

/sequences/edited/groups/selected/outline/border/half/select

/sequences/edited/groups/selected/outline/border/quarter/select

// Line

/sequences/edited/groups/selected/outline/line/normal/select

/sequences/edited/groups/selected/outline/line/boomerang/select

/sequences/edited/groups/selected/outline/line/yoyo/select

// Color

/sequences/edited/groups/selected/filling/color/normal/select

/sequences/edited/groups/selected/filling/color/gradientlinear/select

/sequences/edited/groups/selected/filling/color/gradientradial/select

/sequences/edited/groups/selected/filling/color/gradientangular/select

/sequences/edited/groups/selected/filling/color/gradientdiamond/select

/sequences/edited/groups/selected/filling/color/random/select

// Special

/sequences/edited/groups/selected/filling/special/inside/select

/sequences/edited/groups/selected/filling/special/outside/select

/sequences/edited/groups/selected/filling/special/corner/select

/sequences/edited/groups/selected/filling/special/swipe/select

/sequences/edited/groups/selected/filling/special/swipeglobal/select

/sequences/edited/groups/selected/filling/special/stairs/select

/sequences/edited/groups/selected/filling/special/hypnotic/select

/sequences/edited/groups/selected/filling/special/stripes/select

/sequences/edited/groups/selected/filling/special/doublestripes/select

/sequences/edited/groups/selected/filling/special/mosaic/select

// Structure

/sequences/edited/groups/selected/transformation/structure/radialglow/select

1
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Border
parameters

// Thickness

/sequences/edited/groups/selected/outline/border/basic/thickness/[variable]

// Speed

/sequences/edited/groups/selected/outline/border/blinking/speed/[variable]

/sequences/edited/groups/selected/outline/border/blinking/speed/phaseoffset/value

// Duplications

/sequences/edited/groups/selected/outline/border/basic/duplication/number

/sequences/edited/groups/selected/outline/border/blinking/duplication/inneroffset/value

// Depth

/sequences/edited/groups/selected/outline/border/basic/depth/[variable]

/sequences/edited/groups/selected/outline/border/basic/perspective/scalestroke

/sequences/edited/groups/selected/outline/border/basic/perspective/none

// Path

/sequences/edited/groups/selected/outline/border/basic/origin/default

/sequences/edited/groups/selected/outline/border/basic/origin/center

depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]
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Line
parameters

// Thickness

/sequences/edited/groups/selected/outline/line/normal/thickness/[variable]

// Fade

/sequences/edited/groups/selected/outline/line/normal/fade/[variable]

// Length

/sequences/edited/groups/selected/outline/line/normal/length/[variable]

/sequences/edited/groups/selected/outline/line/normal/dash/number

// Speed

/sequences/edited/groups/selected/outline/line/normal/speed/[variable]

/sequences/edited/groups/selected/outline/line/normal/speed/phaseoffset/value

// Duplications

/sequences/edited/groups/selected/outline/line/normal/duplication/number

/sequences/edited/groups/selected/outline/line/normal/duplication/inneroffset/value

// Depth

/sequences/edited/groups/selected/outline/line/normal/depth/[variable]

/sequences/edited/groups/selected/outline/line/normal/perspective/scalestroke

/sequences/edited/groups/selected/outline/line/normal/perspective/none

// Path

/sequences/edited/groups/selected/outline/line/normal/direction/left

/sequences/edited/groups/selected/outline/line/normal/direction/right

/sequences/edited/groups/selected/outline/line/normal/origin/default

/sequences/edited/groups/selected/outline/line/normal/origin/center

depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]
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Color
parameters

// Motion - Direction

/sequences/edited/groups/selected/filling/gradient/none/direction1 //for "None"
Motion mode

/sequences/edited/groups/selected/filling/gradient/swing/direction1 //for "Swing" &
"Blink" Motion modes

/sequences/edited/groups/selected/filling/gradient/swing/direction2 //for "Swing" &
"Blink" Motion modes

/sequences/edited/groups/selected/filling/gradient/direction/left //for "Rotate" Motion
mode

/sequences/edited/groups/selected/filling/gradient/direction/right //for "Rotate"
Motion mode

// Motion - Speed

/sequences/edited/groups/selected/filling/gradient/rotatespeed/value

// Motion - Phase Offset

/sequences/edited/groups/selected/filling/gradient/none/phaseoffset/value

// Random - Transitions

/sequences/edited/groups/selected/filling/color/random/transition/smooth

/sequences/edited/groups/selected/filling/color/random/transition/none

depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]
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Special
parameters

// Fill Percentage

/sequences/edited/groups/selected/filling/special/inside/fill/[variable]

/sequences/edited/groups/selected/filling/special/inside/fill/phaseoffset/value

// Speed

/sequences/edited/groups/selected/filling/hypnotic/speed/[variable]

/sequences/edited/groups/selected/filling/special/doublestripes/speed2/[variable]

/sequences/edited/groups/selected/filling/special/inside/fill/phaseoffset/value

// Fade

/sequences/edited/groups/selected/filling/special/inside/fade/[variable]

// Width

/sequences/edited/groups/selected/filling/special/doublestripes/width1/[variable]

/sequences/edited/groups/selected/filling/special/doublestripes/width2/[variable]

// Spacing

/sequences/edited/groups/selected/filling/special/doublestripes/spacing1/[variable]

/sequences/edited/groups/selected/filling/special/doublestripes/spacing2/[variable]

// Path

/sequences/edited/groups/selected/filling/special/inside/origin/center

/sequences/edited/groups/selected/filling/special/inside/origin/default

/sequences/edited/groups/selected/filling/special/stripes/direction

/sequences/edited/groups/selected/filling/special/doublestripes/direction2/

depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]
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Snake
parameters

// Apply on

/sequences/edited/groups/selected/filling/snake/color/checkbox

/sequences/edited/groups/selected/filling/snake/special/checkbox

// Path

/sequences/edited/groups/selected/filling/snake/direction/left

/sequences/edited/groups/selected/filling/snake/direction/right

// Step

/sequences/edited/groups/selected/filling/snake/step/sustain/[variable]

/sequences/edited/groups/selected/filling/snake/step/release/[variable]

// Speed

/sequences/edited/groups/selected/filling/snake/speed/value

depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]

Rotation
parameters

// Path

/sequences/edited/groups/selected/transformation/rotation/path/axisx

/sequences/edited/groups/selected/transformation/rotation/path/axisy

/sequences/edited/groups/selected/transformation/rotation/path/axisz

/sequences/edited/groups/selected/transformation/rotation/direction/left

/sequences/edited/groups/selected/transformation/rotation/direction/right

/sequences/edited/groups/selected/transformation/rotation/origin/center

/sequences/edited/groups/selected/transformation/rotation/origin/default

// Speed

/sequences/edited/groups/selected/transformation/rotation/speed/value

/sequences/edited/groups/selected/transformation/rotation/phaseoffset/value

depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]
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Structure
parameters

// Type

/sequences/edited/groups/selected/transformation/structure/elastic/motion/rotate

/sequences/edited/groups/selected/transformation/structure/elastic/motion/swing

/sequences/edited/groups/selected/transformation/structure/elastic/motion/scale

/sequences/edited/groups/selected/transformation/structure/elastic/link/none

/sequences/edited/groups/selected/transformation/structure/elastic/link/line

// Thickness

/sequences/edited/groups/selected/transformation/structure/radialglow/thickness/[variable]

// Depth

/sequences/edited/groups/selected/transformation/structure/roundtrip/depth/[variable]

// Speed

/sequences/edited/groups/selected/transformation/structure/radialglow/speed/[variable]

/sequences/edited/groups/selected/transformation/structure/radialglow/phaseoffset/value

// Instances

/sequences/edited/groups/selected/transformation/structure/radialglow/instances/number

/sequences/edited/groups/selected/transformation/structure/radialglow/instances/multiplier

// Path

/sequences/edited/groups/selected/transformation/structure/wireframe/direction/left

/sequences/edited/groups/selected/transformation/structure/wireframe/direction/right

/sequences/edited/groups/selected/transformation/structure/radialglow/origin/default

/sequences/edited/groups/selected/transformation/structure/radialglow/origin/center

depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]

 

Shapes

Face center
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X
coordinate

/sequences/edited/shapes/selected/center/x/[variable] depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]

Y
coordinate

/sequences/edited/shapes/selected/center/y/[variable] depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]

// possible addresses

/sequences/edited/shapes/selected/center/x/value

/sequences/edited/shapes/selected/center/x/lfo/mode

/sequences/edited/shapes/selected/center/x/lfo/min

/sequences/edited/shapes/selected/center/x/lfo/max

/sequences/edited/shapes/selected/center/x/lfo/tempo

/sequences/edited/shapes/selected/center/x/lfo/speed

/sequences/edited/shapes/selected/center/y/value

/sequences/edited/shapes/selected/center/y/lfo/mode

/sequences/edited/shapes/selected/center/y/lfo/min

/sequences/edited/shapes/selected/center/y/lfo/max

/sequences/edited/shapes/selected/center/y/lfo/tempo

/sequences/edited/shapes/selected/center/y/lfo/speed

 

Player shaders
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Toggle /sequences/[seqName]/shapes/[playerName]/shaders/[shaderName]/toggle

/sequences/edited/shapes/[playerName]/shaders/[shaderName]/toggle

/sequences/[seqName]/shapes/[playerName]/shaders/[n]/toggle

/sequences/edited/shapes/[playerName]/shaders/[n]/toggle

1 (on) or 0 (off)

Parameters /sequences/[seqName]/shapes/[playerName]/shaders/[shaderName]/[parameterName]/[variable]

/sequences/edited/shapes/[playerName]/shaders/[shaderName]/[parameterName]/[variable]

/sequences/[seqName]/shapes/[playerName]/shaders/[n]/[parameterName]/[variable]

/sequences/edited/shapes/[playerName]/shaders/[n]/[parameterName]/[variable]

depends on [variable]
[https://help.heavym.net/hc/en-

us/articles/11763711559058-OSC-API-

Pro#h_01H3Y61DKEJWW5Z59XP2JENS07]

// examples for a player name "Player 2"

// in a sequence named "Seq 1-2"

// with Chroma Zoom.fs, in second position from the bottom of its list

/sequences/seq1-2/shapes/player2/shaders/chromazoom/toggle

/sequences/edited/shapes/player2/shaders/chromazoom/toggle

/sequences/seq1-2/shapes/player2/shaders/2/toggle

/sequences/edited/shapes/player2/shaders/2/toggle

/sequences/seq1-2/shapes/player2/shaders/chromazoom/master_zoom/value

/sequences/seq1-2/shapes/player2/shaders/chromazoom/master_zoom/lfo/mode

/sequences/seq1-2/shapes/player2/shaders/chromazoom/master_zoom/lfo/min

/sequences/seq1-2/shapes/player2/shaders/chromazoom/master_zoom/lfo/max

/sequences/seq1-2/shapes/player2/shaders/chromazoom/master_zoom/lfo/tempo

/sequences/seq1-2/shapes/player2/shaders/chromazoom/master_zoom/lfo/speed

/sequences/edited/shapes/player2/shaders/chromazoom/master_zoom/value

...

 

Sources
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Playback

Playback
mode

/sources/[n]/playbackmode 0.0
Normal

0.5
Restart

1.0 Skip
(only
playlists)

Toggle
"Restart
with
sequence"

/sources/[n]/restartwithseq 1 (on) or 0
(off)

Trigger
media

/sources/[n]/medias/[n]/trigger
// for playlist sources

1

Trigger
next
media

/sources/[n]/next // for playlist
sources

1

Trigger
previous
media

/sources/[n]/previous // for
playlist sources

1

Restart
playlist

/sources/[n]/restart // for
playlist sources

1

Media
loop
mode

/sources/[n]/loop

// for solo sources

/sources/[n]/medias/[n]/loop
// for playlist sources

0.0 Loop

0.33
Follow
(only
playlist)

0.66
Pause

1.0 Stop

// examples for a solo source in 1st position from the top left

/sources/1/playbackmode

/sources/1/restartwithseq

/sources/1/loop

// examples for a playlist source in 2nd position from the top left

// with at least 2 medias

/sources/2/playbackmode

/sources/2/restartwithseq

/sources/2/medias/2/trigger

/sources/2/next
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/sources/2/previous

/sources/2/restart

/sources/2/loop

/sources/2/medias/2/loop

 

Video

Play /
Pause

/sources/[n]/play

// for solo sources

/sources/[n]/medias/[n]/play //
for playlist sources

1 (play) or
0 (pause)

Rewind /sources/[n]/rewind

// for solo sources

/sources/[n]/medias/[n]/rewind
// for playlist sources

1

Volume /sources/[n]/volume

// for solo sources

/sources/[n]/medias/[n]/volume
// for playlist sources

0.0 (mute)
to 1.0
(max)

// examples for a solo video source in 1st position from the top left

/sources/1/play

/sources/1/rewind

/sources/1/volume

// examples for a playlist source in 2nd position from the top left

// with a video in 1st media position

/sources/2/play

/sources/2/rewind

/sources/2/medias/1/volume

 

Shader

Parameters /sources/[n]/[parameterName]/[variable]

// for solo sources

/sources/[n]/medias/[n]/[parameterName]/[variable]
// for playlist sources

depends
on[
variable]

// examples for Bricked.fs in a solo shader source

// in 1st position from the top left

/sources/1/tile/value

/sources/1/tile/lfo/mode

...
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// examples for a playlist source in 2nd position from the top left

// with Bricked.fs in 1st media position

/sources/2/medias/1/tile/value

/sources/2/medias/1/tile/lfo/mode

...

 

Text

Parameters /sources/[n]/align

// for solo sources

/sources/[n]/medias/[n]/align
// for playlist sources

0.0 Left

0.5 Center

1.0 Right

// example for a solo text source in 1st position from the top left

/sources/1/align

// example for a playlist source in 2nd position from the top left

// with a text in 1st media position

/sources/2/medias/1/align

OSC_sequencer_ipad9_2.11_v1.zip[https://help.heavym.net/hc/en-us/article_attachments/14404271333778]10

KB Download[https://help.heavym.net/hc/en-us/article_attachments/14404271333778]

OSC_mix_ipad9_2.11_v1.zip[https://help.heavym.net/hc/en-us/article_attachments/14404303657874]10

KB Download[https://help.heavym.net/hc/en-us/article_attachments/14404303657874]

OSC_groupeffects_ipad9_2.11_v1.zip[https://help.heavym.net/hc/en-us/article_attachments/14404316823058]20

KB Download[https://help.heavym.net/hc/en-us/article_attachments/14404316823058]

project_mix_ipad9_2.11_v1.zip[https://help.heavym.net/hc/en-us/article_attachments/14404330635666]400

KB Download[https://help.heavym.net/hc/en-us/article_attachments/14404330635666]

12.4. Controlling Proxima via DMX / Art-Net
DMX is a standard that is commonly used in stage lighting environments, to communicate between
controllers (like a lighting desk or software) and lights, dimmers, or other fancy special effects devices.

Proxima supports DMX input, via the Art-Net protocol specifically. It means that you can use your lighting
console to send commands to Proxima via a network.
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Setting up an Art-Net connection
First, head over to the DMX / Art-Net tab of the Controls Settings window (from Controls →
Settings... or  in the toolbar).

There, you have three things to configure:

Network: since Art-Net transmits messages over the network, both Proxima and your DMX sender
need to use the same connection (Wifi, Ethernet or Loopback on the same computer for instance).

Subnet / Universe: choose which Subnet and Universe Proxima should listen to so that it is set to
the same as your DMX sender (0:0 by default).

Managing Assignments
Enabling Art-Net Learning

Once your connection is set, you can start assigning buttons, faders or anything your DMX sender has in
store to commands in Proxima. To do so, you have to make the elements in the app interface "learn"
which channel in your DMX interface they should react to.

For that, you need to toggle the Art-Net Learning interface from the Controls window ("Art-Net Learning
mode" button) or menu (Controls → Edit DMX Assignments). A colored overlay will appear over the
elements you can map in the interface.

Note: notice these two new buttons that appear on the left of the sequencer?

Adding assignments

Select an overlay element with your mouse or trackpad (it will be circled in yellow) and just trigger the
control item on your DMX sender that you want to use with it. This will associate the DMX channel and
interface controls together and you'll see it appear in the list in the Controls Settings window.

Once you're done, you can simply toggle the Learning mode off with the same button/menu or with [Esc].

Note: you can assign the same channel to multiple commands at the same time. For example, one single
button on your device can be linked to multiple effect toggles, so that when you hit it, all these effects
turn on at once!

Editing assignments

To edit the assignments, just turn on the Learning mode again. Then, simply select the desired
assignment and trigger the new DMX control you want to use.

Proxima Controlling Proxima Remotely

130 Jan, 11th 2024



Note: you can also directly edit the channel of an assignments in the table.

Deleting assignments

There are 3 possibilities to delete assignments:

When the Learning mode is ON, select an overlay and hit [Delete/Backspace]. This will remove the
selected assignment.

Right-click on a single assignment in the table in the Controls window and click on the "Delete
assignment" 

option. This will remove the selected assignment.

Use the "Delete all assignments" button above the table in the Controls window. This will remove all
DMX assignments in the project.

Saving assignments

The DMX assignments you set are directly saved in your .pxm project file.

Assignment settings

Each assignement you configure has a set of settings, as you can see in the assignments table of the
Controls window.

For DMX assignments, you can edit:

The Channel: simply input a new number to change the channel assigned to this specific
assignment. You don't need to have your lighting desk or app connected or trigger anything in the
learning mode for the change to be applied.

The Range: this setting appears on sliders or spinboxes for instance. By setting a Min and a Max,
you can override the range of the interface element in Proxima. For example if you set the range to 1
- 15 for the Thickness of the Border effect, when you move the fader you have assigned to it the
values will only vary between 1 and 15 no matter how hard you move your fader!
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13. Connecting with Other Apps

Proxima has built-in bridges to help you share visuals or work in sync with other Apps. Here a few
examples of the many existing possibilities.

13.1. Using NDI to share textures between apps over the
network
NDI™ (Network Device Interface) is a protocol that allows you to send and receives video frames between
applications, in real time. Sounds familiar? Well yes, it is like Spout and Syphon, but the catch here is that
is works over the network, so the communicating apps don't have to be on the same computer! The apps
simply have to support NDI and the devices have to be connected to the same network (even over WIFI).

You'll be able to receive and display the feed of other applications in Proxima and, the other way around,
send the Proxima output to another program, either on the same device or not. The protocol is already
included in Proxima, you don't need to install anything. 

Sending the Proximaa output to another app
Don't forget to check that both the sending and the receiving device are connected to the same network!

Enabling output sharing

In order to be able to send the rendering of the Proxima output to another app, first activate output
sharing in the menu Output → Enable NDI. That's all! Now you should see Proxima available as an NDI
source in the receiving app.

Setting up the output resolution

The output that is sent through NDI corresponds to the whole canvas zone, so its resolution depends on
the size of your canvas. By default, it is set to 1920x1080 pixels.

If you want to change this, you need to go through the advanced output setup mode, from Output →
Setup... or  , and change the resolution indicated in the "Canvas Settings" section.

Note: find more info on the canvas and the output in 👉this article [p.23].

Receiving a texture from another app in Proxima
Don't forget to check that both the sending and the receiving device are connected to the same network!

Enabling output sharing in the sender

To receive a feed from another app, you don't need to enable output sharing in Proxima, but you might
need to do it in the app that is sending it.
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Please refer to your app's manual to check if it is compatible with NDI and see how to activate output
sharing.

Selecting a sender in Proxima

To include an NDI stream in Proxima, you first need to 👉add a player shape [p.32], an NDI source in the
Source bin, and connect them together. Then, in the settings of the source, select the available NDI feed
you want. 

The  active /  inactive status of the stream is saved, meaning that if it is not started before Proxima, the
stream selection is still preserved in the project and the stream will automatically start again when the
origin source is turned back ON.

To learn more about all the possibilities of multimedia sources, check out the articles in the dedicated

chapter of this guide, « 👉Managing multimedia sources [p.73] ».

 

Tech stuff
Audio is not supported via NDI In nor Out

8-bit RGBA is used for NDI Out

All NDI In formats are supported (a faster GPU-accelerated conversion is performed for 8-bit UYVY)

13.2. Playing in time with Ableton Link
If you’re already a pro, you can toggle the Ableton Link button in the tempo module to activate it. Now, if you
want to learn more about Link and what it enables you to do first, keep reading!

Even if the TAP tempo function in Proxima is helpful to adjust the tempo to that of a song without
knowing its BPM (tempo in Beats per Minute), it’s not dynamic, so it won’t account for tempo variations
in the music. For example, if you feel a drop coming, you’ll probably want your visuals to speed up to
follow its build-up before it hits! That’s why we’ve introduced Ableton Link : you are now able to
synchronize the Procima BPM value with that of other apps.

In this tutorial, we’ll explain the possibilities that it enables and how it’s integrated within Proxima. Check
out the video tutorial below, or follow the written instructions after it.

https://youtu.be/eI9vDNaKVYs
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What’s Link?

As per the Ableton website[https://www.ableton.com/en/link/], “Link is a technology that keeps devices in time over
a local network, so you can forget the hassle of setting up and focus on playing music.”

The protocol syncs up tempo, beat, and phase between multiple applications that can be running on one
or multiple devices. That way, you can for instance sync Proxima and your other visual animation apps
on one computer, and also keep in time with the DJ’s DAW. All these applications have independent, non-
identical timelines, but Link will allow them to play in time.

Also, although the technology is developed by the Ableton team, you don’t need to have Ableton Live to

use Link! Indeed, Link-enabled apps[https://www.ableton.com/en/link/products/] can use the protocol between
themselves autonomously. For instance, you can link Traktor, Resolume, and Proxima together without
having to install anything.

 

Activating Link and joining a session
The Link activation button is located in the tempo module. Simply click on "Ableton Link" to enable the
protocol.

Note: usually, other apps have more or less the same process to activate Link, but the button can be
hidden by default, so check out their "Preferences" or "Options" menu.

 

When Ableton Link is on, the toggle turns yellow and its label displays the number of peers connected to
the session with you (you’re not included in the count.)

In order to join a session, you have to be on the same local network as the other devices (WiFi, Ethernet,
ad hoc, etc). If it is the case, then you don’t have to do anything else: all connected devices are
automatically added to the session.

When you join the session, the Proxima BPM value is adjusted to the common value of the other devices
already in session and it doesn’t disrupt the session at all. The same goes for all other devices: the
newcomers are always the one aligning their BPM to the common value when joining in.

Once in the session, you can keep performing independently, but remember that all devices will have a
common tempo value and everybody in the Link session is equal and can adjust this value, there’s no
priority. So if you’re VJing with a DJ, be careful: when you change the tempo, it will affect his music too!

Later, if you wish to leave the session, simply click on the toggle again to turn off Link in Proxima. The
session will keep running for the other devices, you won’t disrupt anything by leaving and your BPM value
won’t be altered.
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Proxima timeline and Ableton Link
If your Proxima timeline is in “time mode”, only the tempo will be synchronized with other devices. On the
other hand, if you are in “beat mode”, beat alignment and phase synchronization can be performed.

These concepts allow the visuals in Proxima to match perfectly to your sound. For instance, it’s better if
a tempo-reactive effect hits its peak in-phase with the kick of the drums right? (Like in the video tutorial
above for example.)

In order to accomplish this beat-matching in the Proxima timeline, playback might need to be altered.
Indeed, when you start playing a sequence, its launch might have to be delayed in order for it to fall
perfectly in sync with the timeline of other devices. When this happens, you’ll see the Play button on the
sequence blink. It means it’s waiting until the next key beat to start. 

Note: Ableton Live users, it’s the same principle as the launch of Clips in the Session View.

With this method, you don’t have to be precise and calculate when to start, you can hit play whenever
you’d like and the launched sequence will start on the next key beat (for example, a 4-beat sequence
won’t start playing until the beginning of the next bar.) This is only the case for the first launch of a
sequence, then your timeline will play normally and the next sequences won’t be delayed to wait for a bar.
So remember, if you want to play one sequence each bar, 1 bar = 4 beats!

Note: for a detailed explanation of the musical concepts of tempo synchronization, beat alignment and
phase synchronization, we invite you to consult Ableton’s very thorough Link

documentation[http://ableton.github.io/link/].

Proxima Connecting with Other Apps

Jan, 11th 2024 135

http://ableton.github.io/link/


14. Save & transfer project

This section contains information on how to save Proxima projects and what you can export.

14.1. Collect & Save and file handling
Proxima files are managed as projects, in dedicated folders where all external files can be gathered.

This is intended to make file management and project transfer easier from server to server.

Saving a project
When saving a project, Proxima creates a folder with the name you've chosen. It contains the .pxm file
with the same name and a "MediaFiles" subfolder.

 

Gathering external assets in the MediaFiles folder
If you use external media files in your mapping project, we recommend using the Collect & Save option
when saving (File → Collect Media Files & Save...) to make sure that Proxima always finds them at
reload.

What this option does (in addition to a regular save), is that it creates copies of all the external files in
your project and gathers them in the MediaFiles folder of your project. The path of the file is then
overwritten in the project and at next reload, Proxima will look for your files in the MediaFiles folder in
priority.

The Collect & Save option applies to all types of external files: the ones in Sources (images, GIFs, videos,
imported generative shaders), effects (imported postprocessing shaders), background (background
image) and audio (audio tracks on the sequencer and sequences).

You only need to use this option if you've added new external media to the project (it will then only copy
the ones that don't already exist in MediaFiles), otherwise a regular save is fine.

Note: if you move your project's external files manually in its MediaFiles folder, they will also be found at
reload.

 

14.2. Transfer the project

Transferring a project
If all your external files have been collected in the project's MediaFiles folder, the only thing you need to
do when transferring a project to another server is make sure that you copy or move the full project folder
(containing the MediaFiles folder and the .pxm file). use the export and import features located in the
web interface of Proxima to do it.
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Locating missing files
In the event that a media file goes missing, you'll get this window when loading the project:

This window gives you the possibility to locate the missing files by giving it their new paths (make sure
to collect & save the files afterward!) If you skip this window, you also have the possibility to locate each
file from its associated module in the software (in the Sources panel for Medias, the Properties panel for
player and group shaders, etc).

Even if you don't have the files at hand, you can edit other parts of your project and save safely, missing
files information will still be kept in the backup and you can locate them anytime you want in a later
session. 

Once a file has been located, it recovers all its saved properties in the project (attached player,
parameters, controls assignments, etc).

Note: missing files can be deleted manually from their associated module in the software.
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15. Menus & Glossary

This sections aims to present the Proxima Composer menus and provide you with a comprehensive
guide of the terms related to the software.

15.1. Menus
This article describes all the items in the main Menu Bar. When possible, you'll be redirected to an article
with an in-depth description of the feature the item refers to.

File menu
• New [CTRL/Cmd + N]

This opens up a new empty project. You can’t open multiple projects at once so it will replace the active
one if you already had a project open (in this case, a dialog box asking you if you want to save the current
project before switching will appear.)

The default title for new projects is NewProject.pxm. When a project has some unsaved changes, or if it
is new and has never been saved, you’ll notice an asterisk (*) symbol next to its name in the title bar
(Windows), or a black dot instead of a cross on the quit button (Mac).

• Open... [CTRL/Cmd + O]

This item lets you open an existing Proxima project (a file with the .pxm extension). It opens up a dialog
box that allows you to browse your documents in order to find the desired project.

• Open Recent

This item unfolds a list of recently opened Proxima projects (up to the last 10). Simply click on one of
them to load it.

• Save [CTRL/Cmd + S]

This option saves the active project to your disk. If the project hasn’t yet been saved once, the “Save
as…” dialog box will appear (see below). If it has already been saved at least once, the modifications will
be saved by overwritting the project at the location you specified the first time.

When a project has some unsaved changes, or if it is new and has never been saved, you’ll notice an
asterisk (*) symbol next to its name in the title bar (Windows), or a black dot instead of a cross on the
quit button (Mac).

• Save as… [CTRL/Cmd + Shift + S]

This option saves the active project to your disk. A dialog box will appear, requesting you to browse your
documents and select a location where the Proxima project folder will be created. It has a specific
icon  and the following structure: it contains a .pxm file and a "MediaFiles" subfolder.

It will also let you specify a name for the project, used both for the folder and the file (if you don’t, they
will be saved with the default name “New Project”.)

See 👉« Collect & Save and file handling » [p.136].

• Collect Media Files & Save…

See 👉« Collect & Save and file handling » [p.136].

• Import Media…
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This option lets you import a media in Proxima. When you select this item, it opens up a window that lets
you browse your files in order to find the desired media. Once you confirm your selection, it will be added
to the Sources panel.

• Export as Video…

This option lets you export a video of the project organised in the Timeline.

• Export as Image…

This option lets you export an instant .jpg screenshot of the rendering, at the canvas resolution.
The "Export" folder is located in Documents/HeavyM/ on Windows and User/Library/Application
Support/HeavyM on Mac.

• Quit Proxima [CTRL/Cmd + Q]

This will exit Proxima. If you have an active project with unsaved changes, a dialog box will appear,
asking you if you want to save before closing the software. You can disable this confirmation prompt
from Edit → Preferences... → General → Misc.

 

Edit menu
• Undo [CTRL/Cmd + Z]

This will undo your last action. You can undo up to 100 actions.

Note: settings changes are for the most part not “undoable”. The “undo” option mostly apply to the
creation process (creation and deletion of sequences, shapes, group assignments, etc).

• Redo… [CTRL/Cmd + Y] or [CTRL/Cmd + Shift + Z]

This will cancel your last “undo”. You can redo up to 100 actions.

Note: this only works if there are no actions between “undo” and “redo”.

• Preferences… [CTRL/Cmd + ,]

This item opens up the Preferences window, which contains global configuration options for the
software, like Cursor color, Layers scrolling options, rendering performances, etc.

 

Controls menu
• Keyboard Shortcuts List... [CTRL/Cmd + /]

This item opens up a windows with a list of all the keyboard software shortcuts. 

• Edit Keyboard Assignments

This item toggles the Keyboard learning interface. See « 👉Controlling Proxima Composer with a

Keyboard ». [p.99]

• Edit MIDI Assignments

This item toggles the MIDI learning interface. See « 👉Controlling Proxima Composer with a MIDI

device ». [p.99]

• Edit OSC Assignments

This item toggles the OSC learning interface. See « 👉Controlling Proxima Composer with a mobile or

tablet via OSC  [p.99]».

• Edit DMX Assignments
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This item toggles the Art-Net learning interface. See « 👉Controlling Proxima Composer via DMX / Art-

Net  [p.99]».

• Controls Settings...

This item opens up the Controls  window, which, among other options, allows you to choose an active
MIDI device and see the list of keyboard or MIDI assignments currently set. More on this in 👉the

dedicated section [p.136].

 

Output menu
• Fullscreen

This item allows you to activate a simple fullscreen rendering of your mapping. When you hover over this
item, you’ll see a list develop: those are the available screens where you can display your project on. Just

click on one to launch the projection. See « 👉Setting up the Canvas and launching a projection [p.23] ».

Note: the numbering of the screens follows that of your OS.

• Setup…

This item opens up the Output Setup window. See « 👉Setting up the Canvas and launching a projection
[p.23] ».

• Enable NDI

This option toggles the 👉NDI [p.132] output server.

• Show Cursor

This option toggles the display of the Cursor in your output. You can set its thickness and color in the
Preferences.

• Show Test Card

This option toggles the display of the Test Card in the output. It can also be toggled from the 👉Output

Setup [p.23] window.

• Show Canvas Geometry

This option toggles the display of the control outlines of shapes (vertices, handles, edges that bear the
color of the associated group) in the output (except in NDI textures). 

• Show Selection Highlight

This option toggles the display of a highlight of the selection in the rendering (except in NDI textures).
Any shape that is selected (or if at least one of its vertices is selected) then turns white (with a
transparency if it's only hovered).

 

View menu
• Show Preview

This option toggles the display of the output of your project in the background of the canvas. By default,
it is ON. Know that this feature is resource-intensive and can impacts performance when enabled.

• Show All Centers

This option toggles the display of all Center points (instead of being visible only when their associated

faces are selected.) See « 👉Using the Center to control the perspective of effects  [p.49]».
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• Show Geometry

This option toggles the display of the control outlines of shapes (vertices, handles, edges that bear the
color of the associated group) in the Canvas. 

• Show Screens

This option toggles the display of the outline of output Screens in the Canvas.

• Show Image

This option toggles the display of an image in the background of the canvas. You can set the image you
want in View->Image Settings...

• Image Settings…

This item opens up a window where you can choose the image to use in the background of the canvas
and its display settings. 

• Zoom In [CTRL/Cmd + +]

This item increases the zoom percentage in the work area by 10%.

• Zoom Out [CTRL/Cmd + -]

This item decreases the zoom percentage in the work area by 10%.

• Zoom to Fit [CTRL/Cmd + 0]

This item sets the zoom level to 100% and centers the canvas in your window.

• Enable Magnet Snap [CTRL/Cmd + M]

This option toggles the 👉Magnet Tool [p.45]. 

Help menu
• Ressources...

This item opens the onlien guide.

• Unlink your License...

This item allows you to perform an unlink, the process used to unregister a license from a computer that
frees up a seat on your license. It will first open a dialog box, asking you if you really want to go through
the unlink process.

• Check for Updates...

This option will check if there are updates of the software. If you have the latest version available, a
simple message will tell you so. If you’re not up to date, you’ll be able to launch the update process.

• About Proxima Composer...

This item opens a window that, among other things, lets you know which version of the software you’re

using, gives you access to online information about the legal info[https://heavym.net/en/legal/] about the
company behind the software.
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16. Troubleshooting

Houston we have a problem

Proxima Troubleshooting

142 Jan, 11th 2024


	Proxima
	Licence
	Table des matières
	Welcome
	Safety instructions
	Configuration
	Automating project startup and updating remotely

	Proxima composer Interface
	Overview & Navigation
	The work area
	The top toolbar
	The Mapping panels
	The Content panels
	The Sequencer
	1 & 2 -Sequences
	3 & 4 -Timeline and Cues
	5 & 6 -Audio analysis & Tempo


	Canvas & Output Setup
	Setting up the Canvas and launching a projection
	Configuring an advanced projection setup with multiple displays
	Distorting the Output with the Warping module
	Blending displays seamlessly with the Edge Blending module

	Creating Shapes
	What are Shapes?
	Drawing Faces
	Drawing Masks
	Drawing Players
	Shape manipulation & transformations
	Using Maps to create multiples drawings

	The Creative Tools
	The Magnet
	The Background Image
	The Cursor

	Managing Group Effects
	Adding Group effects in Faces
	Effect parameters & LFOs
	Getting creative: playing with Group Effects & Shaders and building a personal library
	Using the Center to control the perspective of effects
	Group effects glossary

	Managing Group Properties
	Overview of group properties & options
	Mixing groups with blend modes

	Managing Multimedia Content
	Adding & displaying multimedia content
	Using the Slice Selector to crop the input of a player
	Controlling the playback of medias
	Adding effects on players

	The Sequencer
	Module 1: the Sequences
	Module 2: the Timeline
	Audio & tempo reactivity

	Master Shaders
	Adding master effects on the rendering

	Controlling Proxima Remotely
	Controlling Proxima with a Keyboard
	Controlling Proxima with a mobile or tablet via OSC
	OSC API
	Controlling Proxima via DMX / Art-Net

	Connecting with Other Apps
	Using NDI to share textures between apps over the network
	Playing in time with Ableton Link

	Save & transfer project
	Collect & Save and file handling
	Transfer the project

	Menus & Glossary
	Menus

	Troubleshooting


